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Network security

As the KAIROS system intended to be used while connected to a network, the following security risks
exist.
① Leakage or theft of information through the system
② Unauthorized operation of the system by persons with malicious intent
③ Interference with or stoppage of the system by persons with malicious intent
It is your responsibility to take precautions, such as those described below, to protect yourself against
the above network security risks.
Panasonic does not accept any responsibility for damage of this type.
・ Use the system in a network secured by a firewall, etc.
・ Make sure that the system is not infected by computer viruses or other malicious programs (using
a regularly updated antivirus program, anti-spyware program, etc.).
・ Protect your network against unauthorized access by restricting users to those who log in with an
authorized user name and password.
・ After accessing the system as an administrator, be sure to close all web browsers.
・ Change the administrator password periodically.
・ To avoid passwords that can be guessed easily by third parties, set a password of at least 8
characters in length, including at least 3 different types of characters, such as upper case, lower
case, numbers, and symbols.
・ Restrict access to the system by authenticating the users, for example, to prevent setting information
stored on the system from leaking over the network.
・ Do not install the system in locations where the system, cables, and other parts can be easily
damaged or destroyed by persons with malicious intent.
・ Avoid connections that use public lines.
・ The staff of our company and our affiliated companies will never ask for the password directly from
the customer.
Note:
Notes on user authentication
・ User authentication on the system can be performed via basic authentication. If basic authentication
is used without the use of a dedicated authentication device, password leaks may occur.
Usage restrictions
・ We recommend connecting the system, controller, and any computes to the same network segment.
Events based on settings inherent to the network devices, for example, may occur in connections
that include different segments, so be sure to perform checks prior to operation.
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1 Overview
1.1 General

Today, live video production needs to adapt new technologies to create more sense of reality and
new technologies for improving productivity of video production. These technical evolution and
requirements are remarkably advancing; KAIROS will be the solution to meet these requirements.
“KAIROS”—the IT/IP platform is a live video production platform that is developed based on a new
concept and innovative architecture. It incorporates proprietary, ground-breaking software to maximize
the CPU and GPU capacities for video processing.
General-purpose IT equipment is deployed to run on CPU and GPU to take advantage of the most
advanced IT technology. And the proprietary, innovative software technology has enabled
unprecedented flexible live video processing with low latency executed on a GPU, while the open
software architecture ensures excellent system flexibility and scalability.
A variety of video inputs and outputs are available with KAIROS to support not only baseband signals
such as SDI but also new IP signals including ST 2110 and NDI® to realize remote live video production.
KAIROS uses the GPU for the video processing, thus allowing flexible video production using multiple
layers with unrestricted number of MEs or keys and the “CANVAS” screen unhampered by resolution or
format.
Because KAIROS is an IT-based open architecture platform, it enables functional enhancements and
control linkage with external devices by adding application software. With the system integration
capability, KAIROS improves work efficiency and ensures future expandability.
Achieving flexibility in all levels of production unlike any existing hardware-based systems, KAIROS
breaks new ground for live video production.
* NDI® is a registered trademark of NewTek in the United States.
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1.2 Key Features
1.2.1 Transition
In a generic M/E architecture, each Mix/Effects Bus (BGD + a fixed number of Keys) has its own
dedicated transition generator usually limited to one transition type at a time. KAIROS offers an
advanced approach.
In KAIROS, there is no limitation on the number of transitions, types, and combinations of transition
elements (BGD, Key/Layer) per Scene. A transition can be designed to affect multiple elements (usually
layers), and each element can have multiple components. A wide variety of transition types can be
applied to a single transition element simultaneously (e.g., mix and size), and each component of a
transition has its own “Start” and “End” position called “Offset Transition,” which can be adjusted
separately per transition element (BGD, Key/Layer) and transition component (Mix, Wipe, DVE, etc.)
The so-called “Next Transition” bits—selecting multiple transitions at once (e.g.: Trans-BGD, TransLayer-1, Trans-Layer-4, Trans-Layer-5)—will automatically monitor the corresponding LAH-PVW (Look
Ahead Preview), and the multi-selection made can be saved as individual setting(s) within the provided
memory systems (Macro, Scene).

1.2.2 Scene
A Scene is the equivalent of a ME on generic switcher with unique enhancements regarding:
- Number of Layers defined per Scene
- Source Options defined per Layer and per Scene (see next page “1.3 Naming Convention”)
- Unlimited Transitions and Transition-Combinations including combinable Transition-Types
- Cleanfeed adjustable per Scene and per Layer
- X/Y-Resolution adjustable per Scene
- Separate set of Macros per Scene
- Macro assigned to be executed when a Scene receives a tally
- Color-Theme per Scene
- Scenes can be treated like any other regular cross-point (e.g., Cameras, Video-Server, etc.)

1.2.3 Layer
A Layer is like a Keyer on a generic M/E-type switcher for the purpose of compositing. A Layer differs
from a Keyer in that it can contain combinations of multiple Effects (attributes). A specific attribute can
be repeatedly applied to the same layer with differing parameters. As an example, a single layer could
have multiple chroma-keys applied with different key colors selected so as to fix a poorly lit chroma-key
background. All Layers, including BGD-Layer and Aux-Buses, are capable of enabling Bus-Dissolve,
whereby the dissolve-type—apart from Mix-Dissolve—can also select from Wipes, DVE’s, and User
Transitions such as various programable Replay-Wipes.
Every Layer has the ability to link cross-point controls to any other Layer within the Scene. Every Layer
provides its own Color-Theme for the GUI. Layers can be grouped for more refined control. Each Layer
can treat its selected source to automatically fit into the specified Scene-Resolution, be kept in original
size and position, or be adjusted by the user. “Source Options” allows the user to specify the required
sources and their designated position per individual Layer-Bus, which will be reflected in the GUI and
on the Control Panel.
Any Layer can become like the BGD-Layer. The “Preset enable” function is selectable per Layer, which
turns a single bus layer into an A/B bus layer, where the user can preset a source on the B bus to
transition to. Layers, which have “Preset enable” active (such as Background-Layer where this function
is enabled by default), can also mimic a behavior mainly used in Automation (Run-Down) application:
- “Swap” mode is the default and behaves like any generic A/B-Bus. So, when executing a Cut or Auto
transition, the sources selected on the A-Bus and B-Bus will swap after the transition is completed.
- The “Next” mode works like “Swap,” except that after the transition has been executed, the B-Bus
source selection will auto advance to the next source in the bus as user-defined in “Source Options” in
order to mimic an Automation system. If necessary, the auto-selected B-Bus cross-point can be
manually overridden at any time. When reaching the last cross-point on B-Bus, the auto advance will
stop and the B-bus will hold the same source selection.
- “Loop” mode works like next mode, but when reaching the last cross-point on B-Bus and executing a
transition, the B-Bus next source selection will loop back to the beginning of the “Source Options”
assigned to that bus.
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1.3 Naming Convention
• Production

• Environment

= Stored file containing all production-related information including:
• Input/output settings (except IP addresses and Type SDI,
NDI, UDP, Format).
• All Control Panel and GUI settings.
• Multi-Viewer Layouts & Presets, Live View.
• Effects, Color Correction.
• Macros.
• Ram Recorder, Clip Player, Stills.
= All engineering settings such as:
• Input/Output (IP addresses and Type SDI, NDI, UDP,
Format).
• IP-Connection settings (Main Frames, Control Panels,
Kairos Creators).
• Engineering Input Names.

• Setup/Settings

= Environment Settings.

• Ram Recorder

= Uncompressed file-based Clip Player.

• Clip Player

= File-based “visually lossless” Clip Player.

• Stills

= File-based Still Store.

• FX-Input

= Inputs that can contain pre-processed attributes (DVE, Color
Correction, pre-processed Key, etc.). Source for FX-Input can be
derived from a Physical Input or any other internal Source like Ram
Recorder, Clip Player, Stills, etc.

• AUX

= Programmable Output section.

• Live View

= Multi-Viewer Monitoring in GUI.

• Layer

= A Layer is treated like a generic Keyer for the purpose of
compositing, but a layer differs from a Keyer in that it can contain
multiple combinations of attributes—even of the same type—such
as Luminance- and Chroma-keys, Masks, Wipes, DVE’s, Color
Corrections, etc. (see section 1.2.3 Layer).

• Source Options

= Individual available Sources per Bus & Scene.

• Scene

= see section 1.2.2 Scene.

• Clean-Feed Plus

= Every Layer within any Scene level, even when re-entered through
multiple other M/E’s, has its individual (forwarded) attribute/flag
declaring whether it is visible or not on any designated Output.
Unlike a generic M/E architecture, it’s no longer an M/E by M/E
setting, which was restricted by the number of available output
cascades per M/E. KAIROS automatically selects the “correct”
output cascade (A/B/C/D/…) in order to maintain the overall CleanFeed rules.

• CP-Assignment

= Dynamic assignment of Scenes, Buses, Delegations, and various
controls.
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1.4 System Integration
A typical system of KAIROS consists of the following components.
System Integration Example (IP-based):
This system is based on pure IP infrastructure with SDI/IP Gateway and Ethernet switch.

System Integration Example (SDI-based):
This system is based on SDI/HDMI/DP-only infrastructure with Deltacast Flex series.

Note: Install or remove Deltacast Flex modules with Kairos Core (Main Frame) turned off. If the modules
are installed after booting, they may not be recognized.
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IP-based and SDI-based components can also be used together in a KAIROS system.
Besides the Video I/O configurations described in the IP & SDI-based setup, the system can also grow
into various aspects by adding additional KAIROS Cores (Main Frames), KAIROS Controls (Control
Panels), and Kairos Creators (GUI Software installed Windows PCs). Please note that these items do
not have to be physically adjacent and can be connected over a distance using fiber paths.

1.5 Peripheral Devices
Peripheral devices using the following protocols can be connected directly through the Network:
•
•
•

AMP over LAN (Advanced Media Player)
PTZ-Control (Panasonic)
Tally over IP direct (Panasonic cameras)
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1.6 How to get started
1. Once Kairos Core (Main Frame) is powered up, the Multi-viewer outputs can be seen from the
display port terminals (MV1/MV2) on the rear.

MV1

MV2

Note: Before turning on Kairos Core (Main Frame), it is necessary to connect the display port
terminals and turn them on. If the display port terminals are connected after Kairos Core (Main
Frame) is powered up, they may not be recognized.
2. Connect LAN1 of Kairos Core (Main Frame) and Kairos Creator (GUI PC) in the same network.
Open the Kairos Creator and connect to the Kairos Core with appropriate IP address setting.
Default IP address of Kairos Core LAN1: 192.168.10.10
The “MIXER” – “Control” menu is displayed on the Kairos Creator.
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3. Connect Kairos Control (Control Panel) to the same network with appropriate IP address setting.
Default IP address of Kairos Control for its own: 192.168.10.20
Default IP address Kairos Control connecting to: 192.168.10.10
(Please see “4.6 Numeric Keypad Section “Menu”:“: for setting IP address.)
1Gbit Ethernet
Default:
<LAN1> 192.168.10.10

Kairos Core
(Main Frame)

<LAN>

Default:
192.168.10.20

Kairos Control
(Control Panel)

Kairos Creator
(GUI PC)

If the Kairos Control is properly connected to the Kairos Core, source names are displayed on the
lower or/and upper crossbar section.
Source name display area
Upper crossbar section

Lower crossbar section
Source name display area
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1.7 Load & Save Production Behavior
KAIROS remembers the last saved state of the system. When using the “Save” or “Save as…” dialog
to save a Production file to an internal or external drive, the KAIROS Core will also save a local copy to
the internal drive to load from after booting the system.
A factory “Default Production” can be re-established by selecting “New ›” from the “Production” dropdown menu located in the upper left corner of the Kairos Creator GUI. This will open the Production
Template with all factory default settings. By confirming on one of the individual selection buttons, a
factory “Default Production” will be reloaded and started.
Default Production Templates are:
- Empty:
- Only a Main Scene is created.
- Scene “Templates” directory is empty.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09 - IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- Basic:
- Main Scene with Scene examples (Templates) assigned to Bus cross-points.
- Background Layer “PGM PST mode” is set to “Swap.” This can be adjusted in the
GUI/Mixer/Scenes page Parameter View panel on the right side under “Layer
Settings”/“Advanced.” Make sure that the Main scene Background layer is selected in the
“Layers” panel on the left before changing “PGM PST mode.” (for details, see Page 7 in section
“1.2.3 Layer”).
- The example scenes 2Box, 4Box, OTS Left, OTS Right, Title, and Sidecar are derived from the
“Templates” directory created by this “Basic” preset.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09–IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- Automation:
- Scene Container is created for Main Scene with example Scenes from the “Templates” folder
assigned to Bus cross-points.
- Background Layer “PGM PST mode” is set to “Next+Loop.” This can be adjusted in the
GUI/Mixer/Scenes page Parameter View panel on the right side under “Layer
Settings”/“Advanced.” Note that the Main scene Background layer must be selected in the
“Layers” panel on the left.
- The example scenes 2Box, 4Box, OTS Left, OTS Right, Title, and Sidecar are derived from the
“Templates” folder created by this “Automation” preset.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09–IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- 2M/E:
- Scenes are created for Main Scene, M/E1, and the “Templates” folder is empty.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09–IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- M/E’s consist of BGD + 4 Layers.
- 3M/E:
- Scenes are created for Main Scene, M/E1, M/E2, and the “Templates” folder is empty.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09 - IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- M/E’s consist of BGD + 4 Layers.
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- 4M/E:
- Scenes are created for Main Scene, M/E1, M/E2, M/E3, and the “Templates” folder is empty.
- MV1 contains Main-PGM & Main-PVW followed by IN01 - IN08 (style: “10-Split A”).
- MV2 contains IN09 - IN24 (style: 16-Split).
- Main consists of BGD + 2 Layers.
- M/E’s consist of BGD + 4 Layers.
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2 Software Installation & License
2.1 Software Installation:

Using Kairos devises requires membership registration to PASS.
PASS is a website that provides support for Panasonic professional video products owners.
Please visit the following site for more details about software download and installation.
https://panasonic.biz/sav/kairos_e/

2.2.1 Licenses Required for KAIROS:
Every connected Kairos Creator and every participating Kairos Core requires a valid License file in order
to function properly within the system.
The Kairos Creator (GUI Software for PC) needs:
• AT-SFC10 (Software Key for Kairos Creator)
The licenses for Kairos Core (Main Frame) are divided into separate parts, which include several
available License packages so far:
•
•
•
•

AT-SF001 (4K Support)
AT-SF002 (I/O expansion)
AT-SF003 (Canvas Output)
AT-SFE03 (NMOS)

The Kairos Control (Control Panel) does not need a license.
With no license, Kairos Creator displays below:

Picture 2.2.1

System ID is a specific ID for the PC.
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2.2.2 Confirm Installed Licenses
Once the “Kairos Creator” App is running, the “Help” menu in the top left corner allows to select “Install
License,” which is used for the connected Kairos Core.

Picture 2.2.2.1

The installed license files
are listed here.

Picture 2.2.2.2

Please refer to the following site for license installation.
https://panasonic.biz/sav/kairos_e/
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2.2.3 Confirm Software Version:
Once the “Kairos Creator” App is running, the “Help” menu in the top right corner allows to select
“About….”

Picture 2.2.3.1

Picture 2.2.3.2

Software
version
Kairos Creator.

of

Software
version
Kairos Core.

of
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2.3 Emergency Procedure for Lost IP Settings:
In case the 1Gb network adaptor settings (in System Settings Menu) got lost and need to be reconfigured,
here is the description how to proceed. Keep in mind, if those Network settings are lost or unknown, the
actual displayed fields for IP address, Netmask & Gateway (Picture 2.3.1) would be empty, and as a
result, the Kairos Creator can NOT connect anymore to KAIROS Core at all. Therefore, the Network
configuration needs to be done directly on KAIROS Core.

When these settings are lost or
unknown and need to be
reconfigured, follow the steps
described below.
Picture 2.3.1

Before continuing, connect a Keyboard straight to the KAIROS Core and repower the system. There are
Text and objects appearing on screen during boot, such as:

Picture 2.3.2

After a few minutes, a blue background screen is revealed with boot information (Picture 2.3.4). There
is a time slot of approx. 2-3 seconds in order to hit the cursor “up-↑” or “down-↓”-button on the Keyboard
in order to stop the time-out for the auto-boot sequence. Selecting “KairosCore….Network Configuration”
will launch after confirmation of a subroutine to be able to access the 1Gb network adapter settings on
KAIROS Core.
Note: All navigations from now on can be simply done using the arrow/cursor buttons (←↑↓→) on the
connected Keyboard, and the selected item can either be confirmed or canceled using the “Return” or
“Enter” key of the connected Keyboard.

Picture 2.3.4

Use
cursor
up/down
Keyboard buttons to select
the 2nd listed item “Network
Configuration.” Press the
“Return” or “Enter” key to
confirm (Picture 2.3.4).

The next upcoming screen is only informing about the
boot progress….

Picture 2.3.5
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Finally, the main task appears:

Picture 2.3.7

To change the upcoming
selection “Yes/No,” use
the Keyboard cursor
buttons Up/Down. For
selecting
“Ok/Cancel,”
the Keyboard cursor
buttons “Left/Right” are
used. The “Return or
Enter” Keyboard buttons
will confirm the selection.

Picture 2.3.8

Continue with “Yes” and “OK” (Picture 2.3.8).
In this dialog, LAN
adaptor 1 or 2 can be
selected. After confirming
the selected adaptor, the
next upcoming box allows
to enter an IP address
using the connected
Keyboard.

Picture 2.3.10

Picture 2.3.9

When finished, confirm “OK.”
After entering the IP
address and hitting “OK,”
the next 2 dialogs will
handle the according
“Netmask” & “Default
Gateway” settings.
Picture 2.3.11

Picture 2.3.12

After confirming “OK” for the Netmask and Gateway, the final
screen is used to “Apply” the new settings. Use the Keyboard
cursor buttons to select “Apply” and confirm with “OK.” This will
use the new IP-settings and continue to boot KAIROS software.
“Cancel” will ignore the changes and boot KAIROS with the
network settings before this “Network Configuration” task was
started.
Picture 2.3.13
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3 GUI Operations (Graphical User Interface)
3.1 Generic GUI Screen Areas

Main Menu navigation.

Picture 3.1.1

Icon tray with “Main Macro” record button and GPU workload meter.

Menu bar with context sensitive selections.

Status bar & visual indication of IP connection.

3.1.1 GPU-Metering
Depending on the amount of resources being used regarding numbers of Layers,
Scenes, added attributes (e.g., ColCorr, DVE’s, ChromaKey, etc.), Outputs, and so
on, there is a GPU-Meter, located in the top right corner of every GUI Menu page,
next to the Macro-Record button. This monitors the actual workload of the processing
system GPU per connected KAIROS Core. GPU-Meters should not exceed 100%
workload.

Picture 3.1.1.1

Note: Apart from the Kairos Creator GUI, the GPU-Meter can also be added and monitored within the
MV’s (see Pictures 3.3.5.2.6 & 3.3.5.2.8 on page 49).
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3.2 Repeating Menu Patterns
3.2.1 Source/Input Selection
In the “Source/Input” dialog, all KAIROS
sources (including inputs) are listed in groups
and are available for designation as source
selections for Buses, Multi-Viewer windows,
etc. Clips and Stills are available after loading
to RAM.
Single click on a source changes the cursor
focus to the selected source, but the change
will only happen after you click “OK” in lower
right corner of the pop-up window to confirm
the changes and close the window. Doubleclick on a source to set the focus and instantly
change the source without closing the
window. The “Cancel” button opens a new
dialog (Picture 3.2.1.2 on next page) where
the user can choose to “Save,” “Discard,” or
“Cancel” the changes.

Picture 3.2.1.1

Picture 3.2.1.2

This dialog will only open if a Source selection changes.
If no change is made to the Source before the “Cancel”
button is clicked, the window will close immediately.
Clicking the “Cancel” button after changing a source
(Picture 3.2.1.1 on previous page) will open this dialog
(Picture 3.2.1.2). Click “Save” to use the new source and
close this dialog box as well as the “Source Select”
window.

Pressing “Discard” will revert all source changes and close both this dialog box and the “Source Select”
window. “Cancel” (in Picture 3.2.1.2) will close this dialog box without any changes and drop back to the
“Source Select” window (Picture 3.2.1.1 on previous page).

Picture 3.2.1.3

The Source Select window
(Picture 3.2.1.1) can be
opened with a right mouse
click on any layer in the
“Layers” window and clicking
on Select Source (Picture
3.2.1.3). It can also be
opened by clicking on
,
the buttons in “Parameter
View” of “Layer Settings.”
The “Source Select” window
will also open when selecting
sources for Aux Buses and
Multi-Viewer panes.

Picture 3.2.1.4

3.2.2 Source Options
Here, the operator can determine which individual sources are available per Bus.
Note: The available sources can be changed on a Scene-by-Scene and/or Bus-by-Bus basis!
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“Source Options” dialog

Click the pencil
symbol
in “Source Options” (Picture

3.2.1.4 on previous page), in
order to open this dialog
(Picture 3.2.2.1).

Changing the order of sources on a
Bus row.
Delete selected source from a Bus.
Add a full category of sources into a
Bus.

Picture 3.2.2.1

Open the “Select Source” window (described in section 3.2.1) to add
individual sources.

3.2.3 Color Adjustments
The “Select Color” dialog will open wherever color adjustments are required. Clicking a Color-Box in
the “Parameter View” window, for example, allows you to set a specific color for every Background and
Layer per Scene.
Color & Saturation can be adjusted in the Color
pane together with the Luminance slider.
A Color can also be picked from the “Basic colors”
section.
Decimal values can be entered for “Hue, Sat,
Lum” or for individual “Red, Green, Blue.”
Hexadecimal color values can be entered in the
“HTML” box. Any change in one area updates
the other areas simultaneously.
Use the “Pick Screen Color” function to pick a
color from anywhere on the computer screen
surface, including outside the GUI menu.
Up to 16 Presets can be saved in the “Custom
Colors” section.
Picture 3.2.3.1

Hit “OK” to confirm selection or “Cancel” to abort.
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3.3 Menu Delegation & Navigation
3.3.1 Top-Level GUI Menu Bar “Kairos Creator”
3.3.1.1 Production
The Kairos Creator software can be launched using the
Windows Taskbar.

icon, located on the Desktop or in the

Picture 3.3.1.1.1

Click the “Production” tab in the upper left corner and
a drop-down menu appears where Production-related
tasks are handled including “New,” “Load…,” “Save,” &
“Save As….” The five most recent Productions that
were loaded are listed next. Choosing “Exit” will close
the dialog.

Picture 3.3.1.1.2

For more detailed information regarding the individual items of the “Production” drop-down Menu, please
refer to the individual sections in this Manual.
Note: The keyboard shortcuts (if available) listed to the right of some menu commands usually are the same as
standard windows keyboard shortcuts for the same or similar functions.
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3.3.1.2 Settings
The “Settings” tab of the menu bar contains several functions related to IP connection, import & export
environment (engineering setup) files:
Connect – IP-address for Kairos Core connection.
Export environment file—Saves the current Setup file with
a new file name and path.
Import environment file—Opens a file browser to select &
load a Setup file.
Picture 3.3.1.2.1

Picture 3.3.1.2.2

While “Connected” to the
Kairos Core, the actual
displayed IP address is
grayed
out.
When
“Disconnected,” the IP
address can be edited and
confirmed
with
the
“Connect” button.

Picture 3.3.1.2.3

3.3.1.3 Deck A/Deck B

Picture 3.3.1.3.2

When the Mixer/Control page is active,
the “Deck A” and “Deck B” tabs appear
on the menu bar that contain tools to
delegate resources to each control
“Deck.” Deck A is on top and Deck B is
the bottom one. Use [ALT]+A and
[ALT]+B to open these menus.

Picture 3.3.1.3.3

Picture 3.3.1.3.4

Click “Delegate…” to open a Selection window with all the Scene
Directories and Scenes, which are available to be delegated to
this Deck. Directories cannot be delegated, but Scenes within
them can be selected.
Picture 3.3.1.3.1

Note: “Smart Delegation” is only available for the “Deck A” drop-down menu. This selects a special
“Auto Delegation” mode for the GUI/Mixer/Control menu page. For more detailed information, refer to
section 1.7 Load & Save Production Behavior in this manual.
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3.3.1.4 Help
“Server update” within the “Help” drop-down
menu offers the ability to update the Kairos Core
software via Kairos Creator. For more details,
please

refer

to

section

“2.1

Software

Installation:”: starting on page 15 in this manual.
Picture 3.3.1.4.1

The operations for “Install license” within the
“Help” drop-down menu is described in section
“2.2.1 Licenses Required for KAIROS:”: starting
on page 15.in this manual

Picture 3.3.1.4.2

“OSS license info…” from the “Help” drop- down
menu will open a list of “Open Source Software
Information” used in “KAIROS” product. Use the
slider on right hand screen to scroll through the
document.

Picture 3.3.1.4.3

Select “About” from the “Help” drop-down menu:

Here, the “System-Id” information for the “KAIROS CREATOR” (PC) and the “Connected Server” (Kairos
Core) are displayed, which are needed in order to create a valid License-Key for each device.
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3.3.1.5 GUI Tab-Cycling/History
The Kairos Creator GUI menu system remembers the 10 most recent menu pages visited, allowing
quick access or toggling between them. The keyboard shortcut is [CTRL]+[TAB]. Pressing
[CTRL]+[TAB] once will toggle between the most recent menu page and the current one. Pressing
[CTRL]+[TAB] keys opens a selection window in the center of the GUI showing the ten most recent
menu pages after which holding the [CTRL] key and hitting the [TAB] key cycles through the list. When
the [CTRL] key is released, the GUI will switch to the highlighted menu page and close the window.
Now, while keeping the “Ctrl” key pressed, use
the keyboard “Tab” button in single steps in
order to cycle through the displayed list.
Releasing the “Ctrl” key will switch to the
selected menu and also will close the menu
selection window.

3.3.1.6 GUI Undo

Picture 3.3.1.5.1

Kairos Creator GUI also supports multi-level “Undo” (CTRL+Z) functionality.
Note: Undo is not supported for “Insert” and “Delete” operations!

3.3.2 Kairos Creator Menu System
The start screen of Kairos Creator shows the “Mixer” Main Tab. The structure of KairosCreator is a
revolutionary new menu paradigm designed to be only one level deep. This allows the user to jump
directly from their current menu page to any other menu page in a maximum of two menu tab clicks!
Kairos Creator always starts up on the “Control” sub-menu of the “Mixer” main tab. To the right of the
“Mixer,” main tabs are the sub-menu selections for the “Mixer” category. The rest of the main tabs are
listed in the left column below the Mixer main tab.

Picture 3.2.1.

Main Tab

Sub Tabs. Menus within the Main “Mixer” tab selection.

The current main tab and a row of sub-tabs are always displayed across the top of the page.
To change to another menu with one click, select any other sub-tab within the same main tab. This will
open the desired menu page without opening the menu overlay window. In the above example (3.2.1),
the current main tab is “Mixer,” the current sub-tab is “Control,” and the rest of the sub-tabs in this
category (main tab) are “Scenes,” “Transitions,” and “Panel.”
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To change to another menu in two clicks, first click the upper left Main Tab (“Mixer” in this example)
and an overlay selection window will expand to show all of the menu tabs:

Picture 3.2.2.

Main tab for current Menu page.
Current Main tab with current sub-selection in Light Gray.
All other Main tabs in dark gray, displaying their previous sub-selections in Light Gray.
• Second, click any other Menu tab in the overlay to jump to that Menu page to change and close
the overlay window.
• Or click on any Main tab (left column) to go to the last selected item from that row and close the
overlay window. The last selection in each row is indicated by the Light gray button.
• To close the overlay window without changing the Menu page, simply re-select the current page.
In this example, you would click the Main Mixer tab, the Main column Mixer tab, or the Control
sub-tab within the Mixer row to close the overlay window without changing the current
Mixer/Control menu.
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3.3.3 Mixer Tab Selection
3.3.3.1 Control
The Mixer Main Tab contains all the sub-tabs for setting up and controlling the Mixer part of your
production. This is where you unleash most of your creativity!

Picture 3.3.3.1.1

The “Control” page gives you a touch screen software Control Panel (CP). All the buttons displayed on
screen can be used and operated like a hardware control panel. The lever arm (Fader) movement can
be controlled with a left mouse click or using the touch screen by pressing and holding while moving it.
In the upper right corner of every menu page is a “Record Macro” button. Left mouse-click on it or use
the touch screen button to start recording a new Macro in the Main-Macro section.
Right mouse click here to add or subtract elements controlled by the “Next Transition” principle.
Objects selected for “Next Transition” also affect the LAH-PVW (Look ahead Preview) and are
controlled via the Lever arm in addition to the “Cut” and “Auto” buttons below.
Look ahead Preview (LAH-PVW) is calculated from the component(s) including BGD and Layer(s) that
are selected for “Next Transition.” These are usually operated with the Lever arm, the “Cut,” or “Auto”
button below.
Beside the “Next Transition” selection method, each transition can still be executed individually, using
the “Cut” and “Auto” buttons located directly below their respective transition components.
The LAH-PVW shows the expected result of the next transition on the Preview Output before execution:
• Preset Bus (B-Side of enabled A/B-Bus), also when enabled on Layer
• Layer is “Off” but enabled/selected for “Next Transition.”

3.3.3.2 Scenes
The “Scenes” tab activates three dedicated drop-down menus in the menu bar: Edit, Insert, and Layer.
Edit
The Edit menu provides actions specific to
modifying Layers and Scenes. An action selected
from the “Edit” drop-down will be applied to the item
that currently has cursor focus. This could be an
item in either the “Scenes” or the “Layers” window.
The list of Edit functions with their keyboard
shortcuts is displayed to the left in Picture 3.3.3.2.1.
Picture 3.3.3.2.1
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Insert

The “Insert” drop-down menu facilitates the addition
of items to the scene tree. A newly created item will
always be placed into the highlighted item unless it
cannot be created there, in which case it will be
placed at the end of the list at the same level as the
currently selected item. The list of Edit functions
with their keyboard shortcuts are displayed to the
left in Picture 3.3.3.2.2.

Picture 3.3.3.2.2

“New Directory” will open a dialog window to name the new directory. After typing in a name and
confirming with the “OK” button, the newly created directory will appear inside the currently selected
item, except if the current item is a scene. Because a scene cannot contain a directory, a new directory
would be created at the end of the list at the same level of the tree.
“New Scene” will open a simple wizard allowing you to name the new
scene and select the number of layers it should have. When closing
the wizard with “OK,” the item will be dropped into the “Scenes” tree
relative to the current cursor focus according to the abovementioned
rules (Picture 3.3.3.2.2).

Picture 3.3.3.2.3

Note: Even though the drop-down selection for “Layers” in the wizard allows a maximum of 6 Layers +
Background, once the scene has been created, Layers can be added and removed as needed.
“New Layer” and “New Layer Group” only work when a scene is selected in the
scene tree. If something other than a scene is currently highlighted, then selecting
a Layer action from the Edit menu will open a Message Box telling you to “Select
Picture 3.3.3.2.4

a scene first!” Click “OK” to acknowledge the error of your ways and close the
box.

“New Layer” opens a dialog box for you to name the Layer. Click “OK” to close the dialog, and the new
layer will be created on top of the list of layers in the currently selected scene.
“New Layer Group” creates an empty folder on top of the list of layers in the currently selected scene.
Only layers can be placed into the folder, either by creating new layers inside it or by cut/copy/pasting
them from elsewhere.
Layer

Picture 3.3.3.2.5

The following actions can be accessed from the
“Layer” drop-down menu or directly from the listed
keyboard shortcuts for selected Layer.
Select Source [Ctrl+O] =Opens the “Inputs”
selection
(Picture 3.3.3.2.6 on next page).
Assignment
[F10] =Opens the “Source Options”
dialog (Picture 3.2.1.4 on page 21).
Disable Effects [F8] =Disables all effects on the
selected Layer.
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Picture 3.3.3.2.6

Picture 3.3.3.2.7

The “Scenes” panel, in the upper left, contains a hierarchical tree
of the Scenes available in the current running production. The
cursor focus in this example is on the Scene called “Main,” which
in this case (derived from loading a Default Production) is being
used as Main-Program output, showing “On-Air” tally in
“Parameter View.” A right mouse-click on one of the items in the
tree will open a context menu with options to change the order of
the objects, access clipboard functionality, Rename or Delete the
object.
The “Layers” panel displays the current status of Scene: “Main.”
Layer names & priority plus individual color per Bus.
Selected source per Bus.
On/Off state per Bus.
Cursor focus is on the Background A/B bus (gray background).

Picture 3.3.3.2.8

Picture 3.3.3.2.9

Due to the cursor selection in “Layers” window, the
“Parameter View” window is only showing the relevant
Scene settings. All settings here can be changed on a
Scene-by-Scene
basis.
Resolution
(1280×720;
1920×1080; 3840×2160), Scene Color and Tally
indication. The Background Bus color is set to Red and
is displayed in the “Layers” window at the bottom
(Picture 3.3.3.2.8). Since “Background A/B” is selected
in “Layers” window and the fact that there is no other
Layer activated/visible (Picture 3.3.3.2.8), the working
area (Picture 3.3.3.2.6 on top of this page) also shows
a full red screen. The “Advanced” setting allows to Autoexecute a selected Macro, when this Scene gets “OnAir” tally.
When option “AT-SF003 (Canvas)” is installed, the
“Advanced resolution control” can be activated for
independent X/Y-Resolution adjustments.

A right mouse-click on one of the layers
will open a context menu with options to
open the “Select Source” dialog, enable
or disable layer effects, change the order
of the objects, access clipboard
functionality, Rename or Delete the
object.
The
according
keyboard
shortcuts are listed to the right.
Picture 3.3.3.2.10
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Picture 3.3.3.2.11

Since “Layers” panel in this example has the cursor selection on “Background,” there are also
additional controls available in “Layer Settings” under “Parameter View.”
•

Program/Preset bus rows indicated in Red according to the “Layer Settings”-Color.

Picture 3.3.3.2.12

The “Advanced Layer Settings” unfolded in the “Parameter View”
panel present additional Layer controls for Opacity, Source link,
PGM/PST mode (see bottom of Page 7, section “1.2.3 Layer” in
this manual), Mode = Size default settings per Layer (related to
the “Scene Settings” X/Y Resolution), Preset Enabled (or B-Bus),
Clean mask (to enable/disable a Layer from a designated Output),
Dissolve enable per Layer (also available for Aux-Buses/Outputs
and described on Page 7 in this Manual section “1.2.3 Layer”),
adjustment for Dissolve time (duration), selection for Dissolve
effect type (Mix, Wipe, DVE, User), selection for Dissolve mode
(Normal, Reverse, Cross).
Picture 3.3.3.2.13
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Picture 3.3.3.2.14

Changing the cursor selection from “Background” to “Layer-1” in the “Layers” panel changes the
working area from Red (BGD-Color) to Blue (Layer-1 Color) in order to indicate the delegated controls.
The “Layer Settings” in the “Parameter View” panel are now showing “Layer-1” controls, also indicated
by “Blue.”
The source on Layer 1 has been changed from “Black” to an Input named “IN5.” This is shown in the
2nd column of the Layers panel and in the virtual crossbar below the working area, which changes the
layout and color to match the parameters of the currently selected layer.
Notice that “Layer-1” is now visible as indicated by the “eye-ball” in the 3rd column of the “Layers”
panel.

Picture 3.3.3.2.15

“Preset enable” adds A/B bus functionality to the source control for any layer. You can select a source
on either bus by clicking the edit “pencil”
, which will open the source selection dialog box. It also
allows the user to execute any type of A/B-Transition (Mix, Wipe, DVE, User) directly on the Layer, a
feature only available on BGD on other switchers.
Or simply use the automatically added “Preset”-bus control, located at the bottom of the page.
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Picture 3.3.1.3.16

Turning off “Preset enable,” will deactivate the controls for “Source B” in the “Parameter View” panel
and disable the “Preset”-bus control, located at the bottom of the page.
Note: Also, meanwhile created A/B transitions will be affected by turning off “Preset enable.”

3.3.3.3 Tools in Working Area

Picture 3.3.3.3.1

Use the toolbox located under the working area for quick access to the “Select,” “Crop,” “Transform,”
and “Corner Pinning” tools. Once selected, they can be controlled using the mouse and wheel controls
in the working area. Additionally, all tools can also be enabled and modified in the “Parameter View”
panel as described in the following examples.

33

3.3.3.3.1 “Select” tool

Picture 3.3.3.3.1.1

Selected Scene is “2Box.”

Working Area

The six active layers (including BGD) are displayed in the working area by their respective GUI colors.
The two non-active “GFX” & “Plate” layers, as indicated by the missing “eyeballs” in the “Layers” panel,
are not visible in the working area.

Picture 3.3.3.3.1.2

Picture 3.3.3.3.1.3

Left-click an object to select it, and it will be
framed in a light red color. All the surrounding
parameter panels will change to reflect the
currently selected object.

Where multiple layers overlap, a right mouseclick will open a context box allowing you to
select the desired layer.

Picture 3.3.3.3.1.4

Picture 3.3.3.3.1.4
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3.3.3.3.2 “Crop” tool

Picture 3.3.3.3.2.1

Select the “Crop” function in the toolbox to activate the Left, Right, Top, and Bottom crop edge controls.
This will only work if the crop function has been enabled. See “Crop Enable” under “Layer Settings”
described on page 37 in this Manual (Picture 3.3.3.3.2.6). When hovering the mouse over the crop
edges, the focused edge can be grabbed with left mouse click and modified.

Picture 3.3.3.3.2.2
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Picture 3.3.3.3.2.3

Positioning the cursor anywhere inside the crop-enabled image will activate focus on all edges as
indicated in red. This allows click and drag repositioning of the entire crop frame.

Picture 3.3.3.3.2.4

Now the image will crop when dragging the image—while keeping the left mouse button pressed—
toward the screen edges.
Note: The crop automatically ends at the screen edges.
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Picture 3.3.3.3.2.5

Picture 3.3.3.3.2.6

Expand the Crop settings in the “Parameter View” panel below “Layer Settings” to modify the values
with the mouse (using slider or arrows ) or entering numeric values.
If the “Enable” button for Crop is not active
, changes will not be visible on any video output, but a
Preview will be displayed in the GUI viewing pane. Next to the “Enable” button is a “Reset to Default”
values button .

Picture 3.3.3.3.2.7

Picture 3.3.3.3.2.8

Unfold the “Advanced” controls ( ) within “Crop Settings” to expose the “Rounded Corners” and
individual Crop Edge Softness controls. By default, Global softness is enabled for crop edges as
indicated by the checked box (
) next to “Global softness.” Untick the check box for “Global softness”
(

), to enable individual edge softness controls, which you can control with a mouse (using slider or

arrows , or by entering numeric values. When “Global softness” is enabled, the controls for “Rounded
corners” are also activated and can be applied to the Layer.

37

3.3.3.3.3 “Transform” tool

Picture 3.3.3.3.3.1

Picture 3.3.3.3.3.2

Select “Transform” tool underneath the working area to position and resize an image using the
corresponding controls. Positioning the cursor in any cornered yellow box - with left mouse click and
holding, 2D-Size of the image can be modified. Positioning the cursor straight inside the picture, with
left mouse click and holding, allows positioning of the image in 2D space. The crosshair marked yellow
circle is identifying the “Rotation origin” position (aka Rotation-“Axis”), which can be adjusted while
left mouse clicking and holding it and dragging it over the GUI screen in the working area. The other
yellow arrow marked circle
can be used in the same style in order to adjust the “Z-Rotation” value
within the GUI screen.
Apart from “Enable” or “Disable” and “Reset to Default,” the functions “Scale,” “Position” (X & Y or using
the drag-pad right next to it) are also available when expanding the “Transform 2D Settings” within the
“Parameter View” window, allowing to modify the values by mouse—using the slider or arrows —or
by entering numeric values in the designated area right next to the slider controls. Rotation coordinates
in “Parameter View” window are labeled “Rotation origin X/Y” (aka Rotation-“Axis”). Here, numeric
values can be entered or modified using the drag-pad right next to it. Also, the “Rotation” value (Zdirection) can be modified using the slider or arrows —or entering numeric values in the designated
area right next to the slider controls.

Note: When positioning a Layer, regardless of using the “working area” or the “drag-pad” controls, while
holding down the keyboard “Ctrl”-key, only horizontal positioning is applied to the Layer object. When
holding down the keyboard “Shift”-key instead, only vertical positioning is applied to the Layer object.
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3.3.3.3.4 “Corner Pinning” tool

Picture 3.3.3.3.4.1

Picture 3.3.3.3.4.2

The “Corner Pinning” tool allows you to position every corner of an image individually by left mouse
clicking on the corner and dragging it to the desired position within the viewing pane. Clicking the cursor
inside the picture allows you to re-position the image, whether or not the corners are shifted.
In “Parameter View,” numeric values can be entered or modified using the drag-pads next to the value
boxes for each individual corner (“Top left X/Y,” “Top right X/Y,” “Bottom left X/Y,” & “Bottom right X/Y”).
Enable and Disable the effect with the switch and “Reset to Default” with the “rewind” button. Overall,
the Corner Pinning “Interpolation Mode” can be changed between 2D and 3D.
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3.3.4.1 Transitions

Transition Name
& Duration

Picture 3.3.4.1.1

Selected Scene in main folder “Scenes”. Scene “Main” selected.
Layers & default names contained in Scene “Main” indicating ON/OFF (Red) and A/B-Bus availability.
Transition components selected per Transition.

Picture 3.3.4.1.2

When a Transition component is selected, a list of the Transition categories available to that component
is displayed in the “Category” panel. A specific transition can then be selected from the items published
in the effects panel to the right of the categories panel. In this case, only “In/Out Effects” are available
and the “Mix” effect—out of the “Mix In/Out category”—is selected.
Also, a “Parameter View” will show all available modifications for the selected transition type, such as:
manual slider for “Fader” control, Transition “Duration,” the “Mode” for Normal—Reverse run direction,
indicating next run—“Direction” display, which is not needed for “Mix” Transition types.
In the “Transition Effect Settings,” the “Offset” (Start position) and “Length” (Duration) for selected
Transition can be modified. The “Effect” window shows the selected Transition type.
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Picture 3.3.4.1.3

In this example, the selected Transition Component has “A/B-Bus” enabled on Layer-1. This results in 2
separate sections of Transition-Types, visualized in the categories “In/Out Effects” & “A/B Effects” area.
“A/B-Effects” showing a mix effect inside the Layer containing, for example, a PiP (“Picture in Picture”)
or OTS (“Over The Shoulder” box).
In addition to having “A/B-Bus” enabled on Layer-1, a separate “In/Out Effect” can be selected to bring
the layer in and out. Combinations (e.g., “In/Out” & “A>B”) are possible as well.
Available Transition Types are:

Picture 3.3.4.1.4

Note: This grouping of selections has been graphically composited and is not available as an actual
GUI menu. However, all Transition types are available as “In/Out Effects” & “A/B Effects.” The selected
“Category” for “User” at the bottom of “Picture 3.3.4.1.4” is User-definable. So, more effects can be
created and added to the list or unwanted effects can be removed.
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Picture 3.3.4.1.5

Click this button in order to create a new Transition.

Picture 3.3.4.1.6

New Transition created (default name = Transition / Duration = 20 Frames), no Layer component
enabled.
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Picture 3.3.4.1.6

Various Transition-Types applied to Layer components. Layer-2 is not participating in this Transition.
Left-click on a transition component to select a transition type. Right-click in a transition’s column to
open a context menu, which will allow you to set the transition duration, rename it, or delete it. With any
transition component selected, you can left-click the Transition item in the menu bar of Kairos Creator
to set the duration of the transition or use the keyboard shortcut “Ctrl+D.”

Picture 3.3.4.1.7

Picture 3.3.4.1.8

Picture 3.3.4.1.9

“Set duration” opens this pop-up window. Numeric entry and/or
slider control to adjust. Confirm “OK.” “Cancel” will abort the
dialog without changes.

Picture 3.3.4.1.10

“Rename” opens the pop-up with actual name.

Picture 3.3.4.1.12

“Delete” will ask to
confirm the action with
“Yes” or “No” to cancel.

Picture 3.3.4.1.11

Enter a new name, confirm “OK,” and abort with “Cancel.”

Picture 3.3.4.1.13
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Transition
renamed

Picture 3.3.4.1.14

Picture 3.3.4.1.15

Open the “Effects” pull-down menu in the
upper left corner of the Kairos Creator or right
mouse click in the “Category User—In/Out or
User—A/B” in order to create a “new
MoveLinear effect” or a “new ReplayWipe.” A
renaming dialog box opens to start with. The
default name is simply “new effect,” which, of
course, can be customized. Press “OK” to
confirm or “Cancel” to abort the dialog. The
according icon will appear in the designated
“Category—User” area (Picture 3.3.4.1.19).

Picture 3.3.4.1.16

Picture 3.3.4.1.17

Right-click an icon in the User area to access
the “Edit,” “Rename,” and “Delete” functions.
(Picture 3.3.4.1.16).
Picture 3.3.4.1.18

Entering the “Edit” dialog, a 2D start position
can be adjusted, using numeric entries or the
drag-pad for positioning X/Y, and the “Scale”
slider for 2D-Size. Starting from those
modified values will always force a Transition
to interpolate to the former defined Layer
position.

Picture 3.3.4.1.19

Drag-pad
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Picture 3.3.4.1.20

Picture 3.3.4.1.21

Editing a “new Replay Wipe” opens the dialog box where desired Clips for Fill, Key, and Mask sources
can be selected, by clicking the
symbol to open the menu for Clip selection. If a Video Clip contains
an alpha channel (key signal), which is supported by KAIROS, it will not be necessary to select an
“Overlay key” source unless you wish to override it. To perform an A-B transition that matches the
Overlay, an animated mask signal can be associated with the “ReplayWipe” by selecting it as the source
for “A b mask.” Both the Key signal and the Mask signal can be individually inverted by ticking their
respective “invert” check-boxes
<->
. In order to delete a selected Source, use the
box.
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3.3.5 Multi-Viewer Tab Selection
3.3.5.1 Live View

Picture 3.3.5.1.1

Selecting the Multi-Viewer output to be monitored in real time in Kairos Creator GUI—Live View tab.
The Multi-Viewer “Live View” tab allows the user to monitor the Multi-Viewer outputs (MV1 or MV2) in
a connected Kairos Creator GUI, once enabled in “System Settings” (described on page 72 in this
manual).

Picture 3.3.5.1.2
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3.3.5.2 Layout
The Multi-Viewer layouts can be customized in the “Layout” section. This page has a list view of the PiP
sources in the MV Inputs panel on the left, the layout editor in the center, and the usual “Parameter
View” panel on the right. Across the bottom are two layout Preset selector panels: “Factory Presets” and
“User Presets,” which function as explained below.

Picture 3.3.5.2.1

Use left mouse click to apply a Factory Preset to the selected Multi-Viewer canvas as a starting point.
Clear a layout, changing the Multi-Viewer Background Color, adjusting the “Text scale” (Size) and
enable or disable “Show tally borders” can be operated/adjusted in this GUI section per Multi-Viewer.
Up to 12 “User Presets” can be saved here. Right mouse click functions on a Preset position are “Store,
Recall, Rename, Clear.”

Picture 3.3.5.2.2

With the “Select” tool-enabled controls for “Size,” “Position,” “Preview,” On/Off become available by
selecting a tile (tile 9 in this case). Opening the “Advanced” settings allows access to control “Rotate,”
“Label position,” “Text color,” “Background color,” and “Background opacity.” When opening “Source
Settings,” the source selection controls become available. These are independent settings per tile.
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Picture 3.3.5.2.3

Select the “Move” tool to use mouse controls directly on the layout grid. Left mouse click, hold, and
move for positioning. Use the mouse wheel in order to change the size.

Picture 3.3.5.2.4

Changing “Position/Size” settings is reflected in “PiP Settings” column in the “Parameter View” panel.
The drag-pad next to X/Y Position controls can be used as well.
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Picture 3.3.5.2.5

Opening the “Edit” drop-down menu in the upper left
corner exposes a “Clear layout” operation, which will be
executed without any further confirmation. The
keyboard shortcut “Ctrl+Del” does the same thing. Also,
a cursor-focused tile can be deleted or the “Set
Source…” dialog can be launched.

Right-click a PiP (tile 9 in this case), to access the context
menu for that PiP. The “Delete” function where a pop-up
window is asking for confirmation. Also, an “Insert” dialog
or a “Set Source” operation can be launched (described in
Pictures 3.3.5.2.6 & 3.3.5.2.7).

1Picture 3.3.5.2.6

Picture 3.3.5.2.7

The “Insert” function provides the opportunity to add/insert
a “New Window” (Tile), “New Analog Clock,” “New Digital
Clock,” “New Label” (Text), “New GPU-Meter,” and a “New
Countdown.” The individual keyboard shortcuts listed next
to the items can also be used.
Picture 3.3.5.2.8

Picture 3.3.5.2.9

Click the “ ” symbol in “Source Settings” at the bottom of the “Parameter View” panel next to the
“Input” icon (IN7 in this example) to open the “Inputs” overlay window for selection, listing all available
sources. A double left mouse-click on a destination in the “MV Inputs” panel, a right mouse click on
one of the items listed in the “MV Inputs” panel, or a double left mouse-click directly on a Multi-Viewer
tile will open the “Set Source” selection overlay window.
In the overlay, a single click on a source will only change the cursor focus, while a double-click will set
the focus and change the source immediately. Select “OK” in lower right corner of the selection window
to confirm the changes and close the window. “Cancel” terminates the dialog. For more details
regarding source selection, please refer to section “3.2.1 Source/Input Selection” on page 21 in this
manual.
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3.3.6 Macro Tab Selection
3.3.6.1 Control

Individual Macros sections
List of available
Global Macros

Record Button for
Global Macros

Picture 3.3.6.1.1

GUI Macro Bus row with name display for the
selected individual Macro group (picture

Picture 3.3.6.1.2

Individual programable Macro sections for Global,
Scene, and Panel Macros (picture 3.3.6.1.3).
Picture 3.3.6.1.3

Note: “Global Macros” can be recorded and recalled at any time and are not assigned to a specific
Scene (Picture 3.3.6.1.1). Global Macros operations allow to create user-defined subdirectories and are
operated via Kairos Creator GUI only. Global Macros can be copied from/to any other Macro section,
such as Scene Macros & Panel Macros.
“Scene Macros” are unlike “Global Macros,” which belong to their individual “Scene,” visible when
selecting the “Scene” Macro section (Picture 3.3.6.1.2 & 3.3.6.1.3).
“Panel Macros” instead belong to their individual Profile (1-8) and can also be operated on their
designated Control Panel with selected/activated “Profile.” See also section 4.6.1 Macros on page 103.

Picture 3.3.6.1.5

Picture 3.3.6.1.4

Selecting “Scene” for the individual Macro
section will browse the actual Production,
displaying all available Scenes, including
Scene subdirectories (i.e., “Templates”).

When “Panel” gets selected in Kairos Creator
GUI as individual Macro section, all Profiles
(1-8) are listed, showing their containing
Macros when cursor focus on.
Picture 3.3.6.1.6

Picture 3.3.6.1.7
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Picture 3.3.3.1.9

Right mouse click
context menu.

Picture 3.3.6.1.8
Picture 3.3.6.1.10

Use the “Edit” and “Macro” menus in the menu bar to access Edit and Macro management functions.
Right mouse click on the macro icon to open a Macro context menu with all the relevant operations.
Note: The Macro context menu actually combines the “Macro” and “Edit” menu functions in one place.
All actions are related to the cursor-focused object. If no object has cursor focus, the context menu is
shorter. Also, more than one Macro can “Record.”
New Macro (Ctrl+N):

Will create a new, empty Macro in the preselected Macro destination. Default
name “M-#,” indicating “M” for “Menu”-created Macro and “#” for numbering.

New Directory:
(Ctrl+Shift+N)

Creates “New Directory” inside the selected directory.
AVAILABLE FOR “GLOBAL” MACRO SELECTION ONLY!

Play (Enter/Return):

Start playing the selected Macro using the keyboard “Enter” or “Return” key.

Record (Ctrl+R):

Will start recording a Macro, which is in cursor focus. Default name “Rec-#,”
indicating “Rec” for “Record”-created Macro and “#” for numbering.

Stop Record:
(Ctrl+Shift+R)

Stops recording Macro, which is in cursor focus.

Edit (Ctrl+E):

Opens up the “Edit” dialog window (see details on the next page).

Cut (Ctrl+X):

Is cutting out an object into the Clipboard.

Copy (Ctrl+C):

Copies a cursor-focused object into the Clipboard.

Paste (Ctrl+V):

Pastes the Clipboard content into the cursor-focused destination.

Move left (Ctrl+Left):

Moving a cursor-focused Macro to left direction.

Move right (Ctrl+Right): Moving a cursor-focused Macro to right direction.
Rename (F2):

Rename the cursor-focused object.

Delete “Del”:

Will delete the cursor-focused
object after confirmation with “Yes”
in the next panel of this task. “No”
will cancel the dialog and action.

Picture 3.3.6.1.11
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3.3.6.2 Macro Edit
Right mouse click a Macro and select from the context menu “Edit” (Picture 3.3.6.1.8) will open
according “Edit” dialog. The keyboard shortcut “Ctrl+E” on a cursor-focused Macro does the same thing.

Play Macro loaded
into Edit mode.
Import/Load
new Macro

Export
Macro

Picture 3.3.6.2.1

The Macro can be played back while in Edit mode, for example, for testing
Launching the Import/Load or Export function will open a browser to navigate for file location or destination.

3.3.3.2 Apps

Picture 3.3.6.2.2

An editable list of commands (Kairos events) executed by the Macro.
Monitor box for any kind of errors during Macro-editing, such as logical, spelling, syntax, etc.
Save changes and not closing edit dialog.
“Insert Wait” editable pauses in frames or seconds

Close edit dialog without changes.
& open Macro Edit Help

.
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Opening Macro “Edit” dialog and clicking on the “Insert
Wait”
button located in the headline reveals the sub-selection for “Time”
with selectable presets in Microseconds (msec) and Seconds (sec).
Once a pause (Wait state) gets inserted into a Macro, the numbers
can be changed within the editor by simply overwriting and saving
them.
Picture 3.3.6.2.3

The sub-selection “Frame” offers selectable presets in Frames.
Again, once a pause (Wait state) gets inserted into a Macro, the
numbers can be changed within the editor by simply overwriting and
saving them.

Picture 3.3.6.2.4

Picture 3.3.6.2.4

When in Macro Edit dialog, the “Help”
button located in the headline next to the “Insert Wait”
button opens the “Help Macro Description.” This “Help” window provides detailed information regarding
the level of “LUA” interpreter implementation the Macro editor is based on. Using the slider on the right
side in order to navigate through this document.
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3.3.6.3 Apps
Apps are based on the scripting language LUA. Here, 2 independent scripts can be executed and run
in parallel. When saving a production while LUA scripts are running, they will be automatically stored
within the production file. By default, this menu page appears empty.

Delegate App(lication) A/B
Stop/Abort Application
Pause Application
Play Application

Export created Application
Import created Application
Save Modification
Create new Application
Picture 3.3.6.3.1

Pressing the “Create new” button will load a LUA example into the workspace for practicing purposes.

Picture 3.3.6.3.1

This example will work with all Productions containing a “Scene” in top-level directory named “Main” and
a “Transition” called “BgdMix.” Productions created with the built-in wizard, when selecting “Production
> New >” (in upper left corner of the GUI), will always provide these 2 elements. For more details
regarding the available Production types within the wizard, see section “1.7 Load & Save Production
Behavior” on page 13 in this manual.
See next page for more details regarding the LUA script implementation.
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Following functions are available additionally to the regular LUA syntax:
Basic functions:
•
•
•

setup: function is called before the first loop call after running an App.
stop: executed when the App fails or App has been terminated (after the last loop call).
loop: function that is executed in a specified cycle when the App is running.

Model access functions:
<object_path> | <object_id>
•

set( , , )

•

get( , )

•

call( , , )

•

call( , )

•

parent( )

•

first_child( )

•

next_sibling( )

•

object() # get the ObjectID from a path

•

object_type( )

•

path( ) # get the path from an ObjectID

•

parameters( ) (optional)

•

functions( ) (optional)

Note: An Application also provides an AutoStart parameter. If set to 1 (true), the application will be
started after production load.
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3.3.7 Source Tab Selection
3.3.7.1 FX-Inputs
As previously described in Chapter 1.3 Naming Convention, FX-Inputs can be pre-processed,
containing effects such as DVE’s, Color Correction, pre-processed Key among others. A source
for an FX-Input can be derived from a Physical Input or any internal Source like a Ram Recorder,
Clip Player, Stills, etc.
FX-Inputs can be used to create multiple versions of a source with differing upstream attributes like, for
example, an “Overlay” effect (e.g., CG-insert “Coach Cam”) or having various color-corrected versions
of the same source in parallel. There are numerous use cases for FX-Inputs and many different ways
to create them.
To begin, select “FX-Inputs” under the “SOURCES” tab. The default Production has an empty container
in the upper left section of the “FX-Inputs” tree labeled “FX-Inputs.”

Picture 3.3.7.1.1

To create a new FxInput, right-click
on the container icon into which you
wish to add an item and select “New
FxInput…” from the pop-up menu.
Selecting “New Directory…” will
create a new directory inside the
current one. You can also use the
“FxInput” drop-down menu (available
with “Alt+F”), or the keyboard
shortcuts:

Picture 3.3.7.1.2

“Ctrl+N” for “New FxInput”
“Ctrl+Shift+N” for “New Directory”

Picture 3.3.7.1.3

Click the “Edit” drop-down menu (picture 3.3.7.1.4) in the menu
bar to gain access to the “Cut, Copy, Paste, Rename, and Delete”
functions. As in most Windows applications, additional keyboard
shortcuts from the “Edit” dialog are:

Picture 3.3.7.1.4

“Ctrl+X” = “Cut”
“Ctrl+C” = “Copy”
“Ctrl+V” = “Paste”

“F2” = “Rename”
“Del” = “Delete”
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Creating a “New FX-Input” as described on the previous page in Pictures 3.3.7.1.2 & 3.3.7.1.3 or using
the keyboard shortcut “Ctrl+N” will open a pop-up window for further selection (see section “3.2.1
Source/Input Selection”).

Picture 3.3.7.1.5

Available Source groups.
Sources available within “Inputs” group.

Picture 3.3.7.1.6

Picture 3.3.7.1.9

Picture 3.3.7.1.7

Picture 3.3.7.1.8

Rename with the “F2"
keyboard shortcut or the popup/drop-down
dialog
as
shown in the picture. Click
“OK” to confirm and “Cancel”
to abort without changing the
name.

Picture 3.3.7.1.10

Note: For more detailed information, look at section “3.2.1 Source/Input Selection” starting on Page 21.
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Here is an example with multiple directories of FX-Inputs:

Main “FX-Inputs” directory.
Subdirectories within “FX-Inputs.”
Created FX-Inputs in their designated directories.
Empty directory.

Picture 3.3.7.1.11

The “Move Up” & “Move Down” controls, which are used
to change the order of FX-Inputs within a directory, can
be found in the right-click context window.

Picture 3.3.7.1.12

Note: In order to apply any modifications/effects to an FX-Input, use the same controls as previously
described in section “3.3.3.2 Scenes” starting on Page 28 of this manual.
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3.3.7.2 Stills
Note: Kairos Standard version supports a maximum of 4K-resolution only.

Stills directory path

Individual created directories

“Stills” main menu page
Memory usage indicators
MEM usage = GPU RAM
HDD usage = used Disc space

Picture 3.3.7.2.1

Opening the first folder where cursor focus is on “Fill & Key” by left mouse double-click on it. A thumbnail
preview is generated per “Still” regardless of a Still is loaded into RAM or not.

Picture 3.3.7.2.2

Stills directory path
Stills loaded to RAM
Still loading to RAM in progress

New Directory:

Right mouse-click context menu, allowing selected Still to “Load
to RAM.” When selecting a Still, which is already loaded to
RAM, the very first entry in the context menu will change to
“Unload from RAM”. Select a Still in order to “Rename” or
“Delete” it. To create a new folder, use “New Directory,” which
will open a new pop-up window (Picture 3.3.7.2.3), asking for a
new directory. Additional keyboard shortcuts are:
“Ctrl+L” = “Load to RAM”
“F2”
= “Rename”
“Del” = “Delete”

“Ctrl+Shift+N” = “New Directory”
“Ctrl+I”
= “Import Clip”
“Ctrl+E”
= “Export Clip”

Note: Stills that are not loaded into RAM will not be visible in any
of the “Source/Input” selection menus.
Picture 3.3.7.2.3
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The “Export” or “Import” of a Still will open a file directory browser within the GUI to get the desired file
location. When exporting a Still, the format will be the internal “*.rr” file format. When importing an image,
the “rr,” “png,” “jpg,” “tga,” and “tif” file formats are supported.

Picture 3.3.7.2.4

Use “show directory tree” from the “View”
pull-down menu in the menu bar or the
Keyboard shortcut “Ctrl+T” to show or hide
the directory tree on the left of the Stills
page (Picture 3.3.7.2.1 on page 59).
Picture 3.3.7.2.5

The “Show extensions”
function from the “View” pulldown menu will toggle to
“Show” or “Hide” the filespecific format, or use the
Keyboard shortcut “Ctrl+U”
to toggle.

This arrow marker is
indicating that this folder
contains at least one
subdirectory, which is not
visible in the plane view
mode (Picture 3.3.7.2.1).

Picture 3.3.7.2.6
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3.3.7.3 Ram Recorder
Note: Kairos Standard version supports a maximum of 2K-resolution only.

8 Ram Recorder Channels
RamRec directory path
Individual created directories

“Ram Recorder” main menu page
Memory usage indicators
MEM usage = CPU RAM
HDD usage = used Disc space

Picture 3.3.7.3.1

Note: Thumbnails are generated per “Clip” whether a Clip is loaded into Ram or not.

Picture 3.3.7.3.2

Right mouse-click context menu, allowing to “Load to RAM” a
selected Clip. When selecting a Clip, which is already loaded to
RAM, the context menu will change to “Unload from RAM.” A
Clip loading to RAM in progress
Clip already loaded into RAM can be directed to one of the 8
with according progress-bar
playout Channels using “Load” and picking a Channel 1-8 from
the list. Select a Clip in order to “Rename” or “Delete” it.
To create a new folder, use “New Directory” as already explained in the “3.3.7.2 Stills” section on page
59 in this manual. A new Clip can be imported (“Import Clip”) or an existing Clip exported (“Export
Clip”). The functions “Set mark-in/-out” & “Clear mark-in/-out” will be explained on the next page.
Additional keyboard shortcuts are:
“Ctrl+L”
= “Unload from RAM”
“F2”
= “Rename”
“Del”
= “Delete”
“Ctrl+Shift+N” = “New Directory”
“Ctrl+I” = “Import Clip”
“Ctrl+E” = “Export Clip”
Clips loaded to RAM

Note: The thumbnails of the displayed Clips are representing the center frame of the Clip.
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Picture 3.3.7.3.2

“Set mark-in,” “Set mark-out,” “Clear mark-in,” & “Clear mark-out” are Clip-specific functions available in
the Clip-context menu (Picture 3.3.7.3.1) as well as in the Channel-context menu (Picture 3.3.7.3.2) and
are saved as Metadata per Clip. The “Set mark-in” & “Set mark-out” functions can be used in order to
trim a Clip regarding Start-time (TC) and/or End-time (TC).
The “Goto” function can address specific Clip position as listed “Begin,” “End,” “Mark-in (TC),” & “Markout (TC).” The Channel-context menu additionally provides TMCs (Tape Motion Controls) for “Play,”
“Reverse Play,” & “Stop.”

Picture 3.3.7.3.3

Ram Recorder Channel number

RR Channel-1 Loop Mode

Loaded Clip Timecode position

Ram Recorder TMC controls

Clip positioning/shuttle bar

Loaded Clip with thumbnail

Ram Recorder TMCs:

Start

Picture 3.3.7.3.4

Step Reverse
Fast Rewind

Pause

Play Reverse

Step Forward
Play

Fast Forward

End
Loop On/Off
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Like in chapter “3.3.7.2 Stills” (Picture 3.3.7.2.4), selecting “show directory tree” from the “View” pulldown menu in the menu bar (here Picture 3.3.7.3.5), or using the Keyboard shortcut “Ctrl+T,” show or
hide the directory tree on the left of the Clip Browser. Compare below with Picture 3.3.7.2.6 (from page
60 in this manual).

Picture 3.3.7.3.5

The arrow marker at the “Wall” directory is indicating that this folder contains at least one more
subdirectory (3 in this case), which is not visible in the plane view mode (Picture 3.3.7.3.2).
The “Show extensions” function from the “View” pull-down menu will toggle to “Show” or “Hide” the filespecific format, or use the Keyboard shortcut “Ctrl+U” to toggle.
The “Export” or “Import” of a Clip will open a file browser within the GUI to get the desired file location.
When exporting a Clip, the format will be the internal “*.rr” file format. When importing a Clip, the
supported file formats are image sequences from “png,” “jpg,” “tga,” “tif” and clips originated from “mov,”
“mp4,” or exported “rr” files.

Picture 3.3.7.3.6

The “Clip” pull-down menu allows to direct
a selected clip straight into one of the 8
available Ram Recorder Channels, using
the “Load” item and picking a Channel 1-8
from the list. Select a Clip first in order to
“Rename” or “Delete” it. To create a new
folder, use “New Directory” as already
explained on page 61 in “Right mouse-click
context menu” (Picture 3.3.7.3.2). New Clips
can be imported (“Import Clip”) and existing
Clips can be exported (“Export Clip”).

Note: Clips that are not loaded into RAM will not be visible in any of the “Source/Input” selection menus.
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3.3.7.4 Clip Player
Note: Kairos Standard version supports a maximum of 2K-resolution only.

2 Clip Player Channels
Clips directory path

“Clip Player” main menu page

Individual created directories

Memory usage indicator
HDD usage = used Disc space

Picture 3.3.7.4.1

Unlike the Stills and Ram Recorder clips, which have to be loaded into RAM memory first, the Clip
Players perform a “live” decompressed playback from the internal server disk. No additional operation
in terms of conversion is required. Therefore, the clips have to be in “DNxHD,” “H264,” or “AVC-Intra”
format.

Codec

Resolution Formats

DNxHD

YUV 422 10 Bit

YUV 422 10 Bit LE

YUV 422 8 Bit

YUV 420 10 Bit

YUV 420 8 Bit

H264

YUV 422 10 Bit

YUV 422 10 Bit LE

YUV 422 8 Bit

YUV 420 10 Bit

YUV 420 8 Bit

AVC-Intra

YUV 422 10 Bit

YUV 422 10 Bit LE

YUV 422 8 Bit

YUV 420 10 Bit

YUV 420 8 Bit

= Supported Resolution
= Not Supported Resolution
The TMCs are identical to the former described Ram Recorder controls (Page 61, Pictures 3.3.7.3.3 &
3.3.7.3.4). Also, the “View” drop-down menu behaves the same as previously described for the “Stills”
and “Ram Recorder” sections. The “Clips” pull-down menu, with the exception of the number of available
channels, behaves the same as described in the “Ram Recorder” menu on the previous page 63 (Picture
3.3.7.3.6).
Note: Like in “Ram Recorder” menu, the thumbnails of the displayed Clips are representing the center
frame of the Clip.
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3.3.7.5 Color Mattes

Picture 3.3.7.5.1

These three colors are available by default in the Color Mattes tab. In order to create a new Color Matte,
use the “Color Matte” drop-down menu in the upper left corner.
Selecting “New ColorMatte” for a new Color, or
“New Directory,” to create one or several subfolders.
Also, these keyboard shortcuts can be used:
“Ctrl+N”

= “New ColorMatte”

“Ctrl+Shift+N” = “New Directory”
Picture 3.3.7.5.2

When selecting “New ColorMatte”:
A pop-up window appears to enter a name for the “ColorMatte-1.” After
entering the name and confirming with “OK,” the new Matte will be added to
the list. “Cancel” will abort the dialog.

Picture 3.3.7.5.3

Picture 3.3.7.5.4

The “ColorMat Settings” items are:
Tally: On/Off (Color) when visible on designated output.
Position: relative “Wash” position related to the “Angle”
settings.
Softness: Wash-softness between “ColorA” & “ColorB.”
Enable Spin: Activates the “Speed” control and
disables “Angle.”

Picture 3.3.7.5.5

ColorA/B: Pick color pattern to adjust/select
color tone. For more details regarding Color
controls, please refer to section “3.2.3 Color
Adjustments” on page 22.
Picture 3.3.7.5.6
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3.3.8. Config Tab Selection
3.3.8.1 Aux

Cursor
focus

Crossbar for selected AUX bus

Picture 3.3.8.1.1

Aux-2 in cursor focus, indicating “Red”-Tally

. Crossbar can be used for instant “Source-selection.”

Parameter selection per Aux-Bus under “Parameter View” in “Auxbus Settings” and “add effect...”

There are 5 methods to change a source for an Aux-Bus:

Picture 3.3.8.1.2

Picture 3.3.8.1.3

Picture 3.3.8.1.4

Picture 3.3.8.1.5

1.
2.
3.
4.
5.

The Aux-Bus drop-down menu in the Kairos Creator menu bar (Picture 3.3.8.1.2),
Right-click the selected Aux-bus for a pop-up menu (Picture 3.3.8.1.3),
Click the “Set…”-source button in the “Parameter View” GUI section (Picture 3.3.8.1.4),
Click the graphic “Crossbar” section at the bottom of the GUI menu (Picture 3.3.8.1.1),
Use the “Ctrl+O” keyboard shortcut.
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The Input selection dialog will come up next, except when using method 4 (graphic crossbar selection)
as already described in section “3.2.1 Source/Input Selection” starting on Page 21.

Picture 3.3.8.1.6

List of existing Input groups. Cursor focus on “Scenes” group.
Available sources in “Scenes” group. Actual selection for Aux-2 = “Main” (surrounded with blue border).
Note: Groups of sources can contain subdirectories!
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3.3.8.1.1 Tally
There are 3 methods to assign Tally signaling for Aux-Buses/Outputs:

Picture 3.3.8.1.1.1
Picture 3.3.8.1.1.2

KAIROS offers 6 independent Tally systems, indicated in separate colors:
Red
Green
Yellow
Blue
Magenta
Cyan
None

= default “On-Air,”
= default “Preview,”
= default “not used,”
= default “not used,”
= default “not used,”
= default “not used,”
= no Tally,

or “Ctrl+1”
or “Ctrl+2”
or “Ctrl+3”
or “Ctrl+4”
or “Ctrl+5”
or “Ctrl+6”
or “Ctrl+0”

Tally can be modified for each individual Aux-Bus using
the Aux-Bus drop-down menu in the menu bar, the right
mouse click menu at the selected Aux-bus, the “Tally
root” button in the “Parameter View” panel or Keyboard
shortcuts.

Picture 3.3.8.1.1.3

3.3.8.2 Inputs

Picture 3.3.8.2.1

3rd Column displays Tally information per input.
1st Column displays the physical input name; 2nd Column displays the user/production input name.
Symbol for connected remote (external) devices, such as VTR’s, PTZ-Cameras, etc.
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There are 3 ways to “Rename” Inputs:

Picture 3.3.8.2.2

Picture 3.3.8.2.3

1. The “Input” drop-down menu in the Kairos Creator menu bar can be used,
2. the right mouse click menu at the selected “Input,” or
3. the Keyboard shortcut “F2” on focused item.
All dialogs would be continued as follows:

Picture 3.3.8.2.4

Picture 3.3.8.2.5

Selecting an Input where a VTR is connected will enable additional controls:
Clip positioning/shuttle bar

Clip Timecode position

External device TMC commands
Loop Mode On/Off

Available
Clips on
external
device

Right mouse click
context menu.
Loaded Clip

Picture 3.3.8.2.6

Selected device type is VTR

.
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Selecting an Input with a PTZ-Camera connected will enable these additional controls:

Pan, Tilt, Zoom controls with adjustable Speed response & Power status.

Available
PTZ
Camera
Presets.
Use left
mouse
click to
select.

Right mouse click
context menu.

Picture 3.3.8.2.7

Selected device type is PTZ

.

The right mouse click context menu allows for selected item to “Recall preset,” “Set preset” (store
preset), “Delete preset,” or “Rename preset.”

3.3.8.3 Triggers

Right mouse click
context menu.

Picture 3.3.8.3.1

The “Triggers” selection within the “Config”-tab allows to create commands (Http or IP) in order to
address specific functionality on connected network devices, for example, Robotics, Intercom, etc.
Creating a “New Directory…” is also available in order to help organize individual categories of
commands and/or controlled devices (e.g., groups of Robots, PTZ’s, Video Servers, etc.).
Note: The “Delete” function in right mouse click context menu is disabled, since there’s no object existing
(e.g., “Directory,” IP-Command or HTTP-Command), which could be deleted.
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Once Triggers have been created
(Http and/or IP), the right mouse click
context

menu

changes

(Picture

3.3.8.3.2), with additional actions.
The existing “Paste” function from the
“Edit” drop-down menu is now joined
by “Cut” & “Copy.” The “Send”
function for the selected command
can be used for testing or execution.
Additionally, the trigger can be sent
by simply using the “Return” key on a
connected

keyboard

while

the

designated command is selected.

Picture 3.3.8.3.2

Entering the “Edit” dialog from the right mouse click context menu on a HTTP-command:
Picture 3.3.8.3.4

There are 3 different request
methods available to select from:
“GET, POST, PUT.” After editing the
entries (Url, Body) relevant to the
selected method, the dialog can be
confirmed and closed with “OK.”
Changes in the “Body” field must be
confirmed by “save” before use. The
“Send” button allows to send the
entered command (probably for
testing) before closing the dialog.
Selecting “Cancel” brings up a popup window containing the selections
for “Save,” “Discard,” & “Cancel” the
action.

Picture 3.3.8.3.3

Picture 3.3.8.3.5
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Entering the “Edit” dialog from the right mouse click context menu on an IP-command:
Picture 3.3.8.3.4

There are 2 different “Protocol”-types
to select from: “TCP & UDP.” After
editing the necessary entries (Port,
Server, & Command), the dialog can
be confirmed and closed with “OK.”
Changes in the “Command” field
need to be confirmed by “save”
before use. Again, the “Send” button
allows you to send the entered
command (probably for testing)
before closing the dialog. Selecting
“Cancel” brings up a pop-up window
containing the selections for “Save,”
“Discard,” & “Cancel” the action, as
described on previous page (page 71,
Picture 3.3.8.3.5).
Picture 3.3.8.3.3

3.3.9 Setup Tab Selection
3.3.9.1 System Settings

System Settings
Multiviewer
Streaming
PTP Settings

Common
Interface
Settings

Picture 3.3.9.1.1

Picture 3.3.9.1.3

Picture 3.3.9.1.4

Multiviewer Resolutions can be adjusted separately from the AUX-Outputs.

Picture 3.3.9.1.2

The “System Frequency” determines the overall processed system framerate,
applied to all Video-Outputs, including connected Multiviewer. However, every
Output provides individual selectable framerates.
Note: This “System Frequency” is independent from the PTP synchronization
and Video-Inputs.
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Picture 3.3.9.1.5

“Multiviewer streaming,” in general, can be enabled or
disabled using the designated check box
(Picture
3.3.9.1.5). for the streams available in the GUI “Live View”
in “Multi-Viewer” tab selection (see section 3.3.5.1 Live View
on page 46 in this manual).
“MV1-Address” and “MV1-Port” address the stream for
Multiviewer-1 output.
“MV2-Address” and “MV2-Port” address the stream for
Multiviewer-2 output.

Note:
- Please make a difference of 2 or more between MV1-Port and MV2-Port (e.g., 50000 and 50002).
- When any setting is changed here, please restart Kairos Creator to monitor “Live View.”
- It takes approximately 30 seconds until streaming video can be seen after Kairos Creator boots.
- If “Live View” is not displayed, please check the Windows Firewall setting of the PC and make sure
inbound rules for Kairos Creator are enabled.
When “Multiviewer streaming” is set up and enabled (Picture 3.3.9.1.5) the actual Kairos Core IP
address (LAN1 from Picture 3.3.9.1.7) can be used in, for example, “VLC media Player” when selecting
“Media,” going to “Open Network Stream,” and entering into the “Network”-tab:
http://192.168.40.50:1234/multiviewers/0/sdp
http://192.168.40.50:1234/multiviewers/1/sdp

for Multiviewer-1
for Multiviewer-2

Note: Multiple instances of “VLC media Player” can run in parallel on the same Kairos Creator GUI
computer in order to monitor MV-1 & MV-2 simultaneously.

Picture 3.3.9.1.6

In “PTP Settings,” the “GMC ID” defines the “EUI-64” clock
identifier of the grandmaster clock (including manufacturer
and model). EUI-64 = 64-Bit Extended Unique Identifier.
“Interface” determines where the physical connection to the
KAIROS-Core is derived from (“QSFP28-1” in this case).
The “Domain” settings define the appropriate PTP-Network.
All network configurations are set
in the “Common Network Settings”
area. Besides the “Hostname,”
various Network configurations
need to be set up in this menu:
“LAN1”: Onboard wired network
adapter 1 (1 Gb-Lan).
“LAN2”: Onboard wired network
adapter 2 (1 Gb-Lan).
“QSFP28-1”: High-speed Network
interface 1 (100 Gb-Lan).
“QSFP28-2”: High-speed Network
interface 2 (100 Gb-Lan).

Picture 3.3.9.1.7

Network adapter settings:
= Network adapter present.
= Adapter enabled/disabled.

For all needed Network adaptors
or interfaces, the IP address,
Netmask,
and
Gateway
(if
necessary) need to be entered to
function properly.

Note: Network adapter settings are not part of “export/import environment file” operations in Kairos
Creator “Settings” drop-down menu! See section “3.3.1.2 Settings” on page 24 in this manual for details.
Note: QSFP28-2 function is not supported yet.

73

3.3.9.2 Input Settings

Group 1-4
Group 5-8
Group 9-12
Group 13-16
Group 17-20
Group 21-24
Group 25-28
Group 29-32
Picture 3.3.9.2.1

The “Input Settings” GUI menu shows a list of all 32 inputs, each capable of a 3G signal bandwidth.
Note: 32 Inputs are accessible only when license AT-SF002 (I/O expansion) is installed. By default,
there are 24 Inputs available.
Each input format is selectable in between ST2110, SDI, NDI, and UDP (Picture
3.3.9.2.2). For “ST2110” input selection, the corresponding high-speed IP address and
“Port” are required when not handled via NMOS settings (Picture 3.3.9.2.3). The
format per input is auto-sensed and displayed (Picture 3.3.9.2.4).

Picture 3.3.9.2.2

Picture 3.3.9.2.3

Picture 3.3.9.2.4

Note: Interlace format is not supported.
Only the first input out of a group of 4 can select 4K (indicated with the yellow
case all other inputs in that group will be disabled.

symbol), in which

Picture 3.3.9.2.5

Auto-sensing format UHD “3840 × 2160@59p” for “IN1” in Group 1-4 will disable Inputs 2-4.
“IN02, IN03, IN04” are disabled because of “IN01” UHD format.
” is only displayed when the license “AT-SF001” (4K Support) is installed.
Note: The selection for “
4K NDI and 4K UDP are not supported.
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Apart from ST2110 IP inputs (Picture 3.3.9.2.2), up to 8 modules (Deltacast)—4 Inputs each—can be
connected for SDI input signals.

Picture 3.3.9.2.5

(Deltacast is also providing modules for HDMI & DP In/Out)

Picture 3.3.9.2.7

Picture 3.3.9.2.6

Picture 3.3.9.2.8

When selecting “SDI” as input format (Picture 3.3.9.2.5), the next selection
defines the module number 1-8 (Picture 3.3.9.2.6). Each module provides 4
inputs to select from “In 1-4” (Picture 3.3.9.2.7). Finally, Kairos Core can autosense the connected input format, or you can choose directly between 12G
(Single Link), 2SI (2 Sample Interleave), SQD (Square Division). You can also
“Disable” the selected input (Picture 3.3.9.2.8).

For a UDP input selection, the entries for IP and Port number are required:

Picture 3.3.9.2.9

For an “NDI” input, an NDI stream can be selected from the NDI streams published on the network:

Picture 3.3.9.2.10

Default NDI stream selection is “None.”

Picture 3.3.9.2.11

Selecting the drop-down menu on the far right shows the available NDI network streams.

Picture 3.3.9.2.12

After selecting an available network stream and fetching the signal, the source indicator turns green

.

Picture 3.3.9.2.13

The “More…” button to the right of each input opens a pop-up window with
advanced input setup options (Picture 3.3.9.2.14).
Picture 3.3.9.2.14
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“TallyTrigger-Tab”:
In the TallyTrigger-Tab, an external Tally device
such as BFE-GPIO Box, Panasonic Camera can
be set up. The following settings are available
depending on the device type:
IP address of the Tally device.
Port number of the Tally device.
Tally Channel (Red, Green, Yellow, Blue,
Magenta, Cyan)
Device type supported by selected protocol.
Selected AUX-Bus (for Camera Return feed, if
applicable).
Auto-detect device (when supported).

Picture 3.3.9.2.16

“PtzTrigger-Tab”:
The “PtzTrigger” Tab addresses a wide variety
of Panasonic Camera remote controls, including
Tally over IP.
The “Camera” menu contains all Panasonic
Cameras available in KAIROS network (Picture
3.3.9.2.17).

Picture 3.3.9.2.18

Picture 3.3.9.2.17

Simply select the model, for example, “AW-UE150,”
KAIROS will complete all the settings automatically
(Pictures 3.3.9.2.18 & 3.3.9.2.19), including the IP
address and the designated Port number.

Picture 3.3.9.2.19

If necessary, all controls can be set manually by selecting from the
currently supported devices in the corresponding drop-down menu. The
“Auto detect” button in the main “PtzTrigger” Tab helps to explore and
update the network camera device list. As soon as all necessary settings
are completed, the “Available” check-box (first entry on top of the
PtzTrigger-Tab) will be ticked

.

Picture 3.3.9.2.20
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“VtrController-Tab”:
In the “VtrController” Tab, enter the individual IP
address and Port number for a supported device
and then select “Protocol” type for the device. A
dedicated driver for BlackMagic devices, as well
as AMP over LAN protocol (Advanced Media
Protocol), is available (Picture 3.3.9.2.21). If the
connected device supports a multi-channel
infrastructure, it might be necessary to specify
the channel number to “talk” to. When the
settings are completed, hit the “Connect” button

Picture 3.3.9.2.20

to establish communication. The “Available” and
“Connected” check-boxes should indicate

.

Picture 3.3.9.2.21

3.3.9.3 Output Settings

Group 1-4
Group 5-8
Group 9-12
Group 13-16

Picture 3.3.9.3.1

Similar to the “Input Settings,” the “Output Settings” GUI menu shows a list of all
16 outputs, each capable of a 3G signal bandwidth. The output types are
selectable between ST2110, SDI, NDI, and UDP (Picture 3.3.9.3.2).
Note: 16 Outputs are accessible only when license AT-SF002 (I/O expansion) is
installed. By default, there are 12 Outputs available.
Picture 3.3.9.3.2
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Out of a group of 4, only the first output can select 4K (indicated with the yellow
symbol). In this
case, all other outputs in that group will be disabled (see the list of available formats in Picture 3.3.9.3.3).
Outputs 2-4 cannot select a 4K signal. Therefore, there are 2 individual drop-down menus provided to
select the desired/available format (see Picture 3.3.9.3.4).

Picture 3.3.9.3.4

Picture 3.3.9.3.3
Picture 3.3.9.3.3

Note: Interlace format is not supported.
When Output-1 in Group 1-4 is set to any of the provided 4K formats, for example, “3840 × 2160@59p,”
Outputs 2-4 will be disabled (Picture 3.3.9.3.5).

Picture 3.3.9.3.5

Output-1 format selected “3840 × 2160@59p” for 4K.
“OUT2, OUT3, OUT4” are disabled because “OUT1” is set to 4K format “3840 × 2160@59p,”
As described in “3.3.9.2 Input Settings” for IP signals, when an Output is set to IP-Type, the
corresponding “IP-Address” and “Port” number also need to be specified (Picture 3.3.9.3.6).

Picture 3.3.9.3.6
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When configuring an Output-Type to “SDI,” the settings are almost the same like in
section “3.3.9.2 Input Settings.” Start with selecting Output-Type first.

Picture 3.3.9.3.7

Picture 3.3.9.3.8

Select an Output Module 1-8,
only available when Deltacast
Modules are installed (Picture
3.3.9.3.9).

Define Output connector Out 1-4
(Picture 3.3.9.3.10).

Picture 3.3.9.3.10
Picture 3.3.9.3.9

When an NDI Output is created, a valid “Stream name” has to be entered in addition to specifying the
Video-Format, in order for the stream to be identifiable throughout the NDI-Network (Picture 3.3.9.3.11).

Picture 3.3.9.3.11

Apart from individually specifying the Video-Format, NDI Output-Type settings are the same as
previously described in section “3.3.9.2 Input Settings.”

Inputs/Outputs as well as the total number of Inputs/Outputs is
Note: The general availability of
reflecting the various types of installed Kairos options/licenses:
AT-SF001 for 4K Support (default is 3G max)
AT-SF002 for I/O expansion to 32 Inputs (default is 24×3G max) and 16 Outputs (default is 12×3G max).
4K NDI and 4K UDP are not supported.
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3.4 KAIROS Rest API
3.4.1 Rest API Overview
In order to access and control KAIROS via a generic Web-browser, such as Chrome, Edge, etc., the
implemented Rest API can be used. Typical browser shortcuts can be used as well (e.g., F5=refresh,
F11=Fullscreen, etc.). For details, check the corresponding browser command information.

Picture 3.4.1.1

Type in the IP-address and Port-number (in this case, “192.168.40.40” for the IP-address and
adding the Port-number “:1234”) and start browsing. For the upcoming dialog, the “User”
(Kairos) and “Password” need to be entered. For the “Password,” the connected ServerSystem-Id is required. For details, see section “3.3.1.4 Help” in this manual.

3.4.2 AUX-All
When selecting (mouse-click) the item “AUX” (Picture 3.4.1.1 above), the browser is showing all
available Aux buses. Scroll up and down to navigate. Select any cross-point on any designated output
(Aux). When there are more sources than source buttons available (see section 3.2.2 Source Options
page 21), automatically a “Shift”-level is (or multiple “Shift”-levels are) applied to the far-right side of the
source selection buttons.

Picture 3.4.2.1

Designate output (AUX)

Available sources per AUX

Shift levels per source selection
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3.4.3 AUX-Delegation
The “AUX Delegation” selection is providing the controls for AUX-buses in a X/Y style so that the upper
Bus is used to select a specific AUX-bus and the lower bus is providing the individual available source.
Again, when there are more sources (see section 3.2.2 Source Options page 21) than source buttons
available, automatically a “Shift”-level is (or multiple “Shift”-levels are) applied to the far-right side of the
source selection buttons.

Picture 3.4.3.1

3.4.4 Inputs (Tally Indication)
Selecting the tab “Inputs” will show a list of all available external inputs with their designated “Tally”
signalization. In this example, Red-Tally (On-Air/PGM-1) for Input-1, Yellow-Tally (Preview/Preset) for
Input-2, Cyan-Tally (PGM-2) for Input-11, Blue-Tally (PGM-3) for Input-17, Magenta-Tally (PGM-4) for
Input-21 and Green-Tally (PGM-5) for Input-31.

Picture 3.4.4.1

3.4.5 Macros
The “Macro” tab contains all recorded “Global”-Macros for instant recall.

Picture 3.4.5.1

3.4.6 Multiviewer
When selecting the “Multiviewer” tab, a list of all Factory Presets and all User-defined Presets are
displayed and can be directly applied to Multiviewer 1 and/or 2.

Picture 3.4.6.1
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3.4.7 Scenes
The last tab called “Scenes” provides full cross-point control per Bus/Layer on delegated Scene. There
is no Scene selected when entering this tab (Picture 3.4.7.1).

Picture 3.4.7.1

Scene “Main” delegated (Picture 3.4.7.2). Background A & B + 2 Layers.

Picture 3.4.7.2

Scene “ME1” delegated (Picture 3.4.7.3). Background A & B + 4 Layers.

Picture 3.4.7.3

Note: Also in “Scenes” tab—once a Scene is delegated—when there are more sources than source
buttons available (see section 3.2.2 Source Options, page 21), automatically a “Shift”-level is (or multiple
“Shift”-levels are) applied to the far-right side of the source selection buttons.
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4 Control Panel

4.1 General Panel Overview
Upper Crossbar section

Lower Crossbar section

Picture 4.1.1

Upper Transition
section

0

Picture 4.1.2

Picture 4.1.3

Lower Transition
section
The 2 multi-purpose delegable numeric keypads can be used in the upper as
well as in the lower Control Panel section in order to control various elements
within Kairos. At the upper numeric keypad section, there is a USB 2.0
connector located, and an additional connector can be found on the Control
Panel backplane. The sections can be delegated using according buttons,
labeled:
“MACRO” = Control Panel Macros (individual per connected Control Panel).
“VTR”
= Tape Motion Commands (TMC) for Clip Player, RamRecorder.
“TL”
= Timeline (TL) controls (not yet implemented).
“MENU” = “Connection” settings and various “Setup” items regarding IPAddress, Netmask, Gateway, Fader & Joystick calibration,
Brightness, Profiles (Panel), Reboot & Restart.
Picture 4.1.4

Note: USB functions are not supported yet.
The Joystick section in the upper right corner of the Kairos Control Panel can
be used for PTZ-Camera Control, Layer & FxInputs-Transformations & generic
positioning controls. This section will be typically auto-delegated to the
individual requested functionality and/or device.

Picture 4.1.5
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The programmable section in the lower right corner of the Kairos Control Panel
can be used for various controls, such as delegating controls toward the above
located Joystick, that is, FX-Inputs, PTZ-Presets, Layers, etc.
The default layout is working in upstream direction toward the Joystick section,
in order to delegate the appropriate controls.

Picture 4.1.6

4.2 Kairos Creator GUI Panel Tab

Picture 4.2.1

Entering the Kairos Creator GUI Mixer > Panel tab is showing a Control Panel
overview with unselected Panel “Profile” (Picture 4.2.1 above). Selecting
Profile1, for example, is showing the default “Deck-1” & “Deck-2” assignment.
In this case, the upper Control Panel M/E (Deck-1) is delegated to control the
Scene called “ME1,” and the lower Control Panel M/E (Deck-2) is delegated to
control the Scene called “Main” (Picture 4.2.2 on the left).

Picture 4.2.2
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Picture 4.2.3

Selecting “Deck-2” with ME1 assigned to, is highlighting the designated Scene controls and allows to
set up the individual “Module Settings” (Picture 4.2.3).

Picture 4.2.4

Selecting “Deck-1” with Main assigned to, will highlight the corresponding Scene controls and allows
to access the available “Module Settings” (Picture 4.2.4).
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Picture 4.2.5

Using the right mouse-click context menu on either “Deck-1” or “Deck-2”(left) and select “Set
Delegation”, or click on the “ ” symbol next to “Scene” in “Module Settings” (right), will open the
“Source selection” window in order to delegate a static Scene per Deck-1 and/or -2 (Picture 4.2.5).

4.2.1 Smart Delegation

Picture 4.2.9

Picture 4.2.1.1

As long as “Smart Delegation” is
“disabled,” the Modules “Deck-1 & -2”
(Picture 4.2.1.1) will show the
delegated Scenes. The “Module
Settings” in the “Parameter View” is
also reflecting this (Picture 4.2.1.2).
Clicking the “Pen” symbol next to
“Smart delegation” opens the available
selections for the corresponding
Control Panel M/E (PGM, PST,
GROUP1, & GROUP2). Selection is
“PST” from the lower M/E (Deck-1).

Picture 4.2.1.3

Picture 4.2.1.2

Picture 4.2.1.4

After enabling and defining “Smart Delegation” for Deck-2 with PST-Bus from Deck-1, the menu will
update accordingly (Pictures 4.2.1.3–4.2.1.5).
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Picture 4.2.1.5

Note: When “Smart Delegation” mode is enabled and the selected cross-point on the defined/preferred
Bus selection (PGM, PST, GROUP1, or GROUP2) is not a Scene (M/E#), such as a direct Input,
RamRec channel, Still etc., the corresponding M/E (Deck-1 or Deck-2) will appear blanked/undefined in
the Control Panel as well as in Kairos Creator GUI (Pictures 4.2.1.6–4.2.1.8).

Picture 4.2.1.6

Picture 4.2.1.7

Picture 4.2.1.8

When multiple Scenes (M/E’s) need to be selectable for instant delegation, the function “Source Options”
within “Module Settings” in Parameter View is used for that.
Similar to the already described functionality in section “3.2.2 Source Options,” starting on page 21 in
this manual, the “Source Options” operations for Scene delegations are almost equally identical.
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Changing the order
of appearance.
Delete a selected
Scene from the list.
Open dialog to add
new Scene into list
(see picture 4.2.18).

Picture 4.2.1.9

Left mouse-clicking on the pen “ ” symbol next to “Source Options” will open the dialog to organize
the Scene delegation operations regarding adding, deleting, and order of appearance.

Picture 4.2.1.10

When finished organizing the “Source Options” list for Scene
delegations, the selection could look like this:

Note: The content of Scene Directories within the “Source
Options” list will be automatically unpacked when displayed on
the Control Panel. In this case, the “Templates” folder (see
Picture 4.2.11) is containing the Scenes: 2Box, 4Box, OTS Left,
OTS Right, Title, and Sidecar.
Picture 4.2.1.11
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4.3 “New Layout” Wizard

Picture 4.3.1

Picture 4.3.2

To create a “New Layout,” use the right mouse-click
context menu on one of the Profiles 1-8 and confirm “New
Layout….” Or use the “New Layout…” button in
“Parameter View” section underneath “Layout Settings.”
After selecting “New Layout…,” the Layout Wizard dialog
will open for selection:
2-Scene layout with 1 = Main & 2 =
ME1. At the bottom, the preferred
location of the main “Cut” & “Auto”
transition button can be selected.
3-Scene layout with upper CP-ME
divided into 2 halves. 1 = Main, 2 =
ME1 & 3 = ME2. Preferred “Cut” &
“Auto”
location—like
described
above.
4-Scene layout. Every A/B bus pair
refers to a single Scene. 1 = Main, 2 =
ME1, 3 = ME2, & 4 = ME3. Preferred
“Cut”
&
“Auto”
position—like
described above.

Picture 4.3.2

When selecting “Cut left,” the “Cut” transition function is
defaulting to the left button beneath both lever/fader
arms (upper & lower deck). Therefore, the “Auto”
transition function will be located to the right button
position.
When selecting “Cut right,” the “Cut” transition function is
defaulting to the right button beneath both lever/fader
arms (upper & lower deck). Therefore, the “Auto”
transition function will be located to the left button
position.

4-Scene layout with upper CP-ME
divided into 3 parts. 1 = Main, 2 =
ME1, 3 = ME2, & 4 = ME3. Preferred
“Cut”
&
“Auto”
location—like
described above.

Note: Keep in mind that changing the
“Cut” & “Auto” button position also
requires to change physically (for
accuracy reasons) the hardware
Control Panel button labels according
to the Wizard selection.

Note: The described layout settings are using the names “Main,” “ME1,” “ME2,” & “ME3” only as
placeholders for any given Scene names. For that reason, the order and location of the delegated
Scenes is obsolete compared to a generic M/E# type of a video switcher. Also, the colors used for
identification/separation are selected randomly and are not representing the Scene (M/E#) colors used
within a user-defined production.
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In case more than one Scene
(M/E#) is delegated to the upper
Deck, the function keys F1–F8 are
representing additional delegation
functionality

for

the

according

Transition section.
Picture 4.3.3

Picture 4.3.4

F1, F2, & F3 are representing the Scene (M/E#) mapped into the upper Deck. Selecting any of the F1,
F2, or F3 keys manually will force the delegated Scene to be reflected and controlled by the upper
Transition section. The “F8” button is representing an “Auto Delegation Mode.” When the “F8” button is
lit, the “Auto Delegation Mode” is enabled, and any “cross-point action” within the mapped Scenes
(M/E#’s) will auto-delegate and highlight the according F1, F2, or F3 key together with the belonging
Transition section.
Note: This functionality can also be combined with “Smart Delegation” described in section 4.2.1 Smart
Delegation on page 86 when using the example “3 Scenes” or “4 Scenes A” (Picture 4.3.2 on previous
page).
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4.4 Transition Section

Picture 4.4.1

There is a dedicated pair of “Cut” & “Auto” buttons per Transition, each with their individual applicable
“Transition Duration” rate. When press & hold one of the buttons labeled “1-8” right above the “Cut” &
“Auto” pairs of buttons, the lower numeric keypad will be auto-delegated in order to enter a transition
duration rate in frames, or to cancel the dialog.
Fader- (Lever-) arm with “Cut” & “Auto” function buttons in default position underneath (“Cut” = Left,
“Auto” = Right).
Transition delegation buttons 1–8, in order to define the next Transition executed with Fader, “Cut” or
“Auto.” Multiple selections for next Transition elements are also applicable by pressing multiple
delegation buttons at once or press & hold a delegation and add or subtract other delegations.
“T-Dur” button in order to apply Transition duration rate for the “Auto” transition (Main) button beneath
Fader- (Lever-) arm.

Picture 4.4.2

Picture 4.4.3

Right above the Transition display, a row of buttons is located, which are
used to temporarily overwrite a user-defined Transition displayed in the
bottom row (Picture 4.4.2).Together with the enabled buttons “A/B” or
“In/Out,” one of the above-listed Transitions can be used instead and need
to be executed with the main “Auto” transition button or the designated
Lever/Fader arm. However, pressing one of the dedicated “Auto” buttons
(Picture 4.4.1) will always execute the transition originally programmed.
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Note: Selecting multiple “Next Transition” buttons 1–8 will also affect the LAH-Scene Preview output,
displayed on Multiviewer or Aux-Output. LAH = Look Ahead Preview.

Picture 4.4.5

When pressing the “T-Dur” button next to one of the
Lever/Fader arm locations in order to enter a Transition
Duration rate (in Frames), the “Numeric Keypad”
section of the lower Control Panel Deck-1 will be
delegated. Or use the lower Digipot next to the Numeric
Keypad of Deck-1 to enter value.

= Confirm & close dialog
= Backspace for entry corrections
Picture 4.4.4

= 1. press confirmation; 2. press closing dialog

Picture 4.4.7

Picture 4.4.6

Press & hold one of the “Next Transition” selection
buttons (1–8) in Transition section of Deck-1 or Deck2, in order to enter a Transition Duration rate (in
Frames), and the “Numeric Keypad” section of the
lower Control Panel Deck-1 will be delegated. Or use
the lower Digipot next to the Numeric Keypad of Deck1 to enter value.
The Displays are showing the actual Layer-Name with
actual Transition Duration rate.

Note: When start modifying a Transition Duration frame rate, the displayed

button turns into an

button to confirm the new entered frame rate, (allowing multiple duration changes and try-outs),
before closing the dialog with the final
, or
cancel dialog.
See more details regarding the numeric keypad in section “4.6 Numeric Keypad Section “Menu”: starting
on page 97.
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Picture 4.4.8

Changing the order
of appearance for a
selected Transition.

In order to modify/edit the available Transition
types (Picture 4.4.2) used for temporary
overwrite by default, left mouse-click the
function “Transition type overwrite” on a
selected “Profile” & “Deck” in Kairos Creator
GUI in Mixer > Panel tab menu, located top
right under “Parameter View.”
When opening the “Transition type overwrite”
dialog, a default of 8 different Transition types
is listed. The list can contain more entries, but
only the first 8 will be displayed in according
Transition display. Please see Picture 4.4.9 for
more operational instructions.

Open dialog to add
new Transition into
list (Picture 4.4.6).

Delete a selected
Transition from the
list.

Picture 4.4.9

Note: This selection of all available
transitions has been graphically
composited and is not available as an
actual GUI menu. However, all
Transition types are available for
“In/Out Effects” as well as “A/B Effects.”
The selected “Category” for “User” at
the bottom of “Picture 4.4.10” is Userdefinable and can be renamed. So,
more effects can be created and added
to the list or unwanted effects can be
removed.

Picture 4.4.10
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4.5 Control Panel Crossbar Section:

Picture 4.2.20

Name of delegated Scene

Delegated Scene Layer
Shift buttons per Layer
Shift level display
Note: Kairos will automatically create as
many “Shift”-levels as required in order to
represent all assigned cross-points.
Picture 4.2.21

Picture 4.2.22

Press & hold “Delegation” button in top row:

Available Layers and Buses in Scene
“Kairos ”
Bus delegation on “Layer-1” in top row.

Picture 4.2.23

Press & hold “Delegation” button in 2nd row:

Bus delegation on “Layer-2” in 2nd row.

Picture 4.2.24
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Press & hold “Delegation” button in 3rd row:

Bus delegation on “BGD-A” in 3rd row.

Picture 4.2.25

Press & hold “Delegation” button in bottom row:

Bus delegation on “BGD-B” in bottom row.

Picture 4.2.26

Note: After press & hold any of the “Delegation” buttons, Kairos Control Panel allows to change the
actual delegation of the selected Bus to any other listed Layer, such as “BGD-A,” “BGD-B,” “Layer-1,”
“Layer-2,” etc. (default Layer names) or designated Scene- “Macros.”

Press & hold “Delegation” button in top row and select “Deleg”:

All available Bus delegations.

Picture 4.2.27

“Layer-1” is the actual delegation on this Bus.
Note: After selecting Deleg all button press & hold actions can be released.
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After selecting “Deleg” (see last page Picture 4.2.27):

All Scenes in listed order created in “Source Options” (see 3.2.2 Source Options).

Picture 4.2.28

“Kairos” is the actual delegated Scene for this Deck.
Note: The content of Scene Directories within the “Source Options” list will be automatically unpacked
when displayed on the Control Panel. In this case, the “Templates” folder (see Picture 4.2.19) is
containing the Scenes: 2Box, 4Box, OTS Left, OTS Right, Title, and Sidecar.
Press & hold “Delegation” button in top row and select “Split”:

All available delegations.

Picture 4.2.27

“Layer-1” is the actual delegation for this Bus.
Note: “Split” operation allows to separate every Bus individually into 2 halves. So instead of controlling
only one single Layer per Bus, 2 delegations per Bus are applicable.

Picture 4.2.29

Source displays
Shift Delegation
Cross-points buttons
Shift Delegation
Status upper left “Split” segment:
Scene = Kairos, Layer-1 delegated, 2nd Shift
level, selected source = “Logo 1st.rr”

Source displays
Shift Delegation
Cross-points buttons
Shift Delegation
Status upper right “Split” segment:
Scene = Kairos, Layer-2 delegated, Unshifted,
selected source = “Esports with Alpha”

Status lower left “Split” segment:
Status lower right “Split” segment:
Scene = Kairos, Layer-3 delegated, 4th Shift level, Scene = Kairos, Layer-4 delegated, 2nd Shift
selected source = “FxLower 3rd”
level, selected source = “Off”
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4.6 Numeric Keypad Section “Menu”:
After powering up the Kairos Core and Control Panel, an IPaddress needs to be entered in order to establish a network
connection in between.
The delegation of the “Numeric Keypad” sections in upper
and lower Deck are set to “Menu” delegation.
Once a connection is established, the system will remember
the IP-address and auto-connect after reboot.
To establish an initial connection, press the “Connect”
button in the upper or lower “Numeric Keypad” sections.
Note: Only the lower “Numeric Keypad” (Deck-1) will show
the connected Kairos Core server address permanently in
the main “Menu” dialog (Picture 4.6.1).

Picture 4.6.1

After pressing the “Connect” button in main “Menu” dialog
of upper or lower Decks “Numeric Keypad” section (Picture
4.6.1), the upcoming dialog allows to enter an IP-address
for a Kairos Core server in order to connect with the Control
Panel (Picture 4.6.2).
Use the “Backspace”
Use the “Cancel”
Use the

Picture 4.6.2

button as needed.
button to abort the dialog.

button to confirm and close the entry.

Pressing the “Setup” button in main “Menu” dialog of upper
or lower Decks “Numeric Keypad” section (Picture 4.6.1), all
relevant local “Settings” for this Control Panel can be
monitored, accessed, and/or modified (Picture 4.6.3).
= IP-Address setting for Control Panel
= Netmask setting for Control Panel
= Gateway address setting for Control Panel
= Fader Calibration dialog
= Joystick Calibration dialog
= Brightness adjustment (button backlight intensity)
= Profile selection Control Panel 1–8
= Information Software Version (Read only)
= Reboot Control Panel

Picture 4.6.3

= Restart Control Panel Application Software
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= IP-Address setting for Control Panel
Allows to set the Control Panel IP-Address.
Use the “Backspace”
Use the “Cancel”
Use the

button as needed.
button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.4

= Netmask setting for Control Panel
Allows to set the Control Panel Netmask.
Use the “Backspace”
Use the “Cancel”
Use the

button as needed.
button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.5

= Gateway address setting for Control Panel
Allows to set the Control Panel Gateway address.
Use the “Backspace”
Use the “Cancel”
Use the

button as needed.
button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.6
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Picture 4.6.7

= Fader Calibration dialog
Follow instructions displayed in upper Transition section.
“STEP 1: MOVE ALL FADERS TO MIN/DOWN POSITION”
Press “OK” to continue or “Cancel” to abort.

Picture 4.6.8

= Fader Calibration dialog
Follow instructions displayed in upper Transition section.
“STEP 2: MOVE ALL FADERS TO MAX/UP POSITION”
Press “OK” to confirm and finish or “Cancel” to abort.
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Picture 4.6.9

= Joystick Calibration dialog
Follow instructions displayed in upper Transition section.
“1. Rotate Z axis in Clockwise and Counterclockwise direction to Max Limits.”
“2. Rotate Joystick Clockwise and Counterclockwise in a full circle 2–3 times to be sure.”
Press “OK” to confirm or “Cancel” to abort.
= Brightness control
Brightness adjustment (button backlight intensity)
Use Numeric Keypad or lower Digipot to enter the value.
Use the “Backspace”
Use the “Cancel”
Use the

button as needed.
button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.10
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= Profile selection Control Panel 1–8
Use button 1–8 in order to recall the designated Panel
Profile (see section 4.3 “New Layout” wizard).
Use the “Cancel”
Use the

button to abort the dialog.

button to confirm and close the entry.

Note: If Profile setting is changed in the Kairos Creator,
please reselect Profile-# on the Control Panel.

Picture 4.6.11

= Info regarding Software Version
Information regarding installed software version. This is a
read-only information.
Use the “Cancel”

button to abort the dialog.

Picture 4.6.12

= High/Low LED button Contrast
Use the buttons “High,” “Mid,” or “Low” in order to select the
preferred contrast setting.
When selecting “Sapphire” mode, the Kairos Control Panel
will disable all button colors, except “Tally On-Air” indication,
and turns selection buttons into “Sapphire” (blue) color tone.
Use the “Cancel”
Use the

button to abort the dialog.

button to confirm and close the entry.

101

= Reboot Control Panel
Note: This will cause a full reboot of the Control Panel,
including Operating System and Application Software,
similar to a power cycle.
Use the “Cancel”
Use the

button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.13

= Restart Control Panel
Note: This will cause a restart of the Control Panel
Application Software only.
Use the “Cancel”
Use the

button to abort the dialog.

button to confirm and close the entry.

Picture 4.6.14

The 2 Digipots located above the Numeric Keypad delegation buttons can be
used for mainly 2 things:
- the lower Digipot—in the upper as well as in the lower Deck—can adjust
Transition Duration times, once delegated by according function. When
delegated by one of the Main “T-DUR” buttons located right above the Fader
arms, the upper Digipot does not provide any functionality (yet!).

Picture 4.6.15

- the upper Digipot—in the upper as well as in the lower Deck—once delegated
by according “Next Transition” delegation 1–8, can adjust Transition attributes
such as “Norm, Reverse, or Norm/Reverse” run directions for DVE or Wipe
transitions, if assigned for designated “Next Transition” delegation.
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4.6.1 Macros
When Numeric Keypad section is delegated to “Macro,”
various operations can be executed such as Recall, Record,
Insert Pause, select Bank, and Delete.
Note: Panel-Macros belong to their Panel-Profile (1–8).
Previous Bank║Macros 1-2 (Bank1-2 Macros)║Next Bank

= Macro recorded via Control Panel “Record” function.
= Macro recorded via Kairos Creator GUI Menu.
= Record new Control Panel Macro.
= Delete Control Panel Macro.

Picture 4.6.1.1

When pressing the “Record” button, the Numeric Keypad
display turns into an “Insert Delay” keypad with multiple
different default selections in numbered in Frames:
1, 3, 5, 10, 30, 50, 100, 300, & 500.
Note: The listed delay times can also be pressed multiple
times to result in a specific time.
So, for example, the requested “Delay” time is 46 Frames:
Press 30 + 10 + 3 + 3 = 46, or any other
comparable/reasonable combination.
Press “Record” again to stop recording.

Picture 4.6.1.2

Once recording is stopped, the display shows the Macro
recall page with an added new “Panel Macro.”
= Added new “Panel Macro” with default name.
Note: Kairos Creator GUI can be used for renaming Macros
and sort the list of appearance. Also Cut, Copy, and Paste
functionality is supported by Kairos Creator GUI across all
available Macro locations & destinations.

Picture 4.6.1.3
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To “Delete” a Control Panel Macro, press and hold the
“Delete” button in the lower left corner of the numeric
Keypad section (when delegated to “Macro”) and click on
the Macro, which needs to be deleted. This is executed
instantly with no further safety request.
Note: Press and hold the “Delete” button allows multiple
Macros to be selected in a row, which will be instantly
removed after selection.

Picture 4.6.1.4

4.6.2 VTR
When Numeric Keypad section is delegated to “VTR,” all
internal and external VTR/Server type of devices can be
controlled. Using the arrows “Left” & “Right” to cycle through
all available device list.
Device Type
Previous
Timecode Position
Device
Clip Name

Next
Device

Selected device is Clip Player Channel-1.
TMC = Tape Motion Commands (Stopped after Clip load)
Loop = Loop Mode On/Off (Off)

Picture 4.6.2.1

When Numeric Keypad section is delegated to “VTR,” all
internal and external VTR/Server type of devices can be
controlled. Using the arrows “Left” & “Right” to cycle through
all available device list.
Device Type
Previous
Timecode Position
Device
Clip Name

Next
Device

Selected device is Ram Recorder Channel-1.
TMC = Tape Motion Commands (Play with Loop On)
Loop = Loop Mode On/Off (On)

Picture 4.6.2.2
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4.6.3 TL
Not implemented yet.

4.7 Joystick Delegation:
The programmable section in the lower right corner of the Kairos Control Panel can be used for various
controls, such as delegating controls toward the above-located Joystick, that is, FX-Inputs, PTZ-Presets,
Scenes (M/E#’s), Layers, etc.
The default layout is working in upstream direction toward the Joystick section, in order to delegate the
appropriate controls.
Display for selected item.
Joystick delegation.
Sub-selection for selected
item (FxInputs, PTZ,
Scenes, etc.).
Selectable Joystick controls.
Selectable items for Joystick
delegation (e.g., FxInputs,
PTZ, Scenes, etc.).
Selection buttons for the
above-listed items.
Note: If more than 8 items
are available, the last button
in the lower right corner turns
into “Shift” functionality.
Picture 4.7.2

Picture 4.7.1

Selectable Layers within
Scene “Kairos” for Joystick
delegation.
Joystick delegation remains
empty until Layer with
enabled Transforms gets
selected.

Scene “Kairos” is selected
and highlighted in Joystick
delegation section.

Picture 4.7.3

Picture 4.7.4
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“Layer-1” in Scene “Kairos”
is selected and highlighted
in Joystick delegation
Joystick delegation shows
available Transforms for
“Layer-1” (Crop & Trans2D).

Scene “Kairos” is selected
and highlighted in Joystick
delegation section.

Picture 4.7.5

Picture 4.7.6

“Layer-1” in Scene “Kairos”
is selected and highlighted
in Joystick delegation
Delegation enabled for
“Layer-1”—“Trans2D”
Joystick controls.

Scene “Kairos” is selected
and highlighted in Joystick
delegation section.

Picture 4.7.7

Picture 4.7.8

Note: Kairos will remember the last delegated Joystick control per selected Layer. To disable Joystick
control, deselect the Transform control (Crop, Trans2D, etc.), the selected Layer or the entire main
selection for “FxInputs,” “PTZ,” “Scene,” etc.
The right Joystick button acts like an acceleration button for all Joystick
control axis and assigned function, such as Transform2D, Crop, etc.

No function implemented yet on the left Joystick button. For future SWRelease, a “Clear to Default” function for selected control (such as
Transform2D, Crop, etc.) is under investigation.
Picture 4.7.9
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